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Περίληψη 

 

 Η παρούσα διπλωματική εργασία εξετάζει τη μεταβολή της ελεύθερης 

επιφάνειας σε ανοικτό αγωγό, με και χωρίς την παρουσία αναβαθμών. Στόχος της 

μελέτης είναι η ανάλυση και η κατανόηση των φαινομένων που σχετίζονται με τη 

ροή σε ανοικτούς αγωγούς στον πυθμένα των οποίων διαμορφώνονται αναβαθμοί ή 

εμπόδια, καθώς και ο τρόπος με τον οποίο οι σχηματισμοί αυτοί επηρεάζουν τη 

συμπεριφορά της ροής και τη διαμόρφωση της ελεύθερης επιφάνειας. 

Αρχικά, πραγματοποιείται μια θεωρητική ανασκόπηση των βασικών αρχών 

της υδραυλικής των ανοικτών αγωγών, ενώ στη συνέχεια, παρουσιάζεται η 

μεθοδολογία της αριθμητικής προσομοίωσης που χρησιμοποιήθηκε για την μελέτη 

της ροής με χρήση κατάλληλου λογισμικού. Τέλος παρουσιάζονται αναλυτικά τα 

αποτελέσματα που προέκυψαν βάσει των αριθμητικών προσομοιώσεων για διάφορες 

περιπτώσεις ροής υπεράνω αναβαθμών ή σχηματισμών πυθμένα.  
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Abstract 

 

 

This thesis examines the variation of the free surface in an open conductor, 

with and without the presence of weirs. The aim of the study is to analyze and 

understand the phenomena associated with flow in open pipelines in the bottom of 

which terraces or obstacles are formed, and how these formations affect the flow 

behavior and the free surface configuration. 

First, a theoretical review of the basic principles of open pipeline hydraulics is 

given, followed by a presentation of the numerical simulation methodology used to 

study the flow using appropriate software. Finally, the results obtained based on the 

numerical simulations for various cases of flow over weir or bottom formations are 

presented in detail.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



6  

Πίνακας περιεχομένων 

 
ΥΠΕΥΘΥΝΗ ΔΗΛΩΣΗ ΣΠΟΥΔΑΣΤΩΝ .................................................................................... 2 

Πρόλογος .......................................................................................................................... 3 

Περίληψη .......................................................................................................................... 4 

Abstract ............................................................................................................................ 5 

Πίνακας περιεχομένων ...................................................................................................... 6 

Κατάλογος εικόνων ........................................................................................................... 7 

Κατάλογος πινάκων......................................................................................................... 10 

Κατάλογος διαγραμμάτων .............................................................................................. 10 

Κατάλογος εξισώσεων ................................................................................................. 11 

Κατάλογος γραφημάτων ............................................................................................. 11 

1 Κεφάλαιο 1: Θεωρητικό υπόβαθρο .............................................................................. 12 

1.1 Ορισμός Ρευστού – Το Συνεχές Μέσον ................................................................ 12 

1.2 Ανοικτοί αγωγοί .................................................................................................. 12 

1.3 Τύποι Ανοικτών Αγωγών: Τεχνητοί και Φυσικοί .................................................. 13 

1.3.1 Φυσικοί Αγωγοί ........................................................................................... 13 

1.3.2 Τεχνητοί Αγωγοί .......................................................................................... 15 

1.4 Ταξινόμηση ροών σε ανοικτούς αγωγούς ............................................................. 17 

1.4.1 Μόνιμη / Μη μόνιμη ροή ............................................................................. 18 

1.4.2 Ομοιόμορφη ροή .......................................................................................... 18 

1.5 Ενέργεια .............................................................................................................. 19 

1.5.1 Γραμμή Ενέργειας ........................................................................................ 19 

1.5.2 Πιεζομετρική Γραμμή .................................................................................. 19 

1.5.3 Στρωτή και Τυρβώδης Ροή ........................................................................... 20 

2 Κεφάλαιο 2: Έννοιες και εξισώσεις ............................................................................. 21 

2.1 Αριθμός Froude ................................................................................................... 21 

2.2 Αρχή διατήρησης της μάζας (εξίσωση συνέχειας) ................................................ 22 

2.3 Αρχή διατήρησης της ορμής................................................................................. 22 

2.4 Αρχή διατήρησης της ενέργειας (εξίσωση ενέργειας) ........................................... 22 

2.5 Συντελεστής Manning .......................................................................................... 23 

2.6 Υδραυλικό άλμα .................................................................................................. 25 

2.6.1 Τύποι Υδραυλικών Αλμάτων........................................................................ 26 

2.6.2 Μήκος υδραυλικού άλματος ......................................................................... 28 



7  

2.7 Διατομή ελέγχου .................................................................................................. 28 

2.8 Αναβαθμοί ........................................................................................................... 28 

2.8.1 Πλεονεκτήματα των Αναβαθμών και Εμποδίων............................................ 30 

2.9 Σχηματισμός θινών λόγω επίδρασης ανέμου ........................................................ 31 

2.10 Σχηματισμός θινών σε πυθμένα ανοικτού αγωγού ................................................ 32 

3 Κεφάλαιο 3: HEC RAS ............................................................................................... 34 

3.1 Περιγραφή του υδραυλικού μοντέλου .................................................................. 34 

3.2 Ανάπτυξη και Ιστορικό ........................................................................................ 34 

3.3 Τι Είναι το HEC-RAS .......................................................................................... 34 

3.4 Εφαρμογές του HEC-RAS ................................................................................... 35 

3.5 Λειτουργίες και Τεχνολογία ................................................................................. 35 

3.6 Προβλήματα που Λύνει το HEC-RAS .................................................................. 36 

3.7 Παρουσίαση λειτουργίας προγράμματος HEC-RAS ............................................. 37 

4 Κεφάλαιο 4: Αριθμητικά αποτελέσματα και ανάλυση .................................................. 53 

4.1 Σενάριο 1: Ροή ανοικτού αγωγού υπεράνω ορθογωνικού αναβαθμού ................... 56 

4.2 Σενάριο 2: Εγκάρσια τοποθέτηση ορθογωνικού και τραπεζοειδούς αναβαθμού 

καθορισμένου ύψους ....................................................................................................... 57 

Ψηφιακά μοντέλα 2 & 3: ................................................................................................. 57 

4.3 Σενάριο 3: Τραπεζοειδής αναβαθμός διαφορετικού ύψους σε δύο ψηφιακά μοντέλα

 62 

4.4 Σενάριο 4: Ανοικτός αγωγός με κλίση, χωρίς εμπόδιο .......................................... 64 

4.5 Σενάριο  5: Κλιμακωτές θίνες σε όλο το μήκος του ανοικτού αγωγού ................... 65 

4.6 Σενάριο 6: Θίνες ύψους 0,25 m σε ανοικτό αγωγό κλίσης 0,35/1000 m/m ............ 66 

4.7 Σενάριο 7: Θίνες ίδιου ύψους σε ανοικτό αγωγό κλίσης 0,106/1000 m/m Ψηφιακό 

μοντέλο 9: ....................................................................................................................... 68 

5 Κεφάλαιο 5: Συμπεράσματα ........................................................................................ 70 

6 Πηγές .......................................................................................................................... 73 

6.1 Βιβλιογραφία ....................................................................................................... 73 

6.2 Διαδικτυακές πηγές .............................................................................................. 73 

6.3 Πηγές εικόνων ..................................................................................................... 73 

6.4 Πηγές πινάκων ..................................................................................................... 74 

 

Κατάλογος εικόνων 

 



8  

Εικόνα 1 : Κοίτη ποταμού Αχελώου ........................................................................ 13 

Εικόνα 2: Ρέμα Πικροδάφνης .................................................................................. 14 

Εικόνα 3: Χείμαρρος Σερρών .................................................................................. 15 

Εικόνα 4: Ρέμα Λευκάδας ....................................................................................... 15 

Εικόνα 5: Ενέργεια ροής ......................................................................................... 20 

Εικόνα 6: Υδραυλικό άλμα ...................................................................................... 25 

Εικόνα 7: Κυματοειδές άλμα ................................................................................... 26 

Εικόνα 8: Ασθενές άλμα .......................................................................................... 26 

Εικόνα 9: Ταλαντούμενο άλμα ................................................................................ 27 

Εικόνα 10: Σταθερό άλμα ........................................................................................ 27 

Εικόνα 11:Ισχυρό άλμα ........................................................................................... 27 

Εικόνα 12: Ορθογωνικός αναβαθμός ....................................................................... 30 

Εικόνα 13: Τραπεζοειδής αναβαθμός ...................................................................... 30 

Εικόνα 14: Μορφολογία θινών ................................................................................ 32 

Εικόνα 15: Δημιουργία φακέλου προς αποθήκευση των σχετικών αρχείων. ............ 38 

Εικόνα 16: Εκκίνηση του προγράμματος. ................................................................ 38 

Εικόνα 17: Δημιουργία προγράμματος. ................................................................... 39 

Εικόνα 18: Επιλογή αρχικού δημιουργηθέντα φακέλου για αποθήκευση δεδομένων.

 ................................................................................................................................ 39 

Εικόνα 19: Επιλογή Geometry Data......................................................................... 40 

Εικόνα 20: Σχεδίαση με το χέρι υποτιθέμενου μοντέλου και ονοματοδοσία του. ..... 40 

Εικόνα 21: Εντολή Cross Section Data. ................................................................... 41 

Εικόνα 22: Options -> Add a new Cross Section. .................................................... 41 

Εικόνα 23: Εκκίνηση αρίθμησης διατομών. ............................................................. 42 

Εικόνα 24 Προσδιορισμός γεωμετρικών χαρακτηριστικών της διατομής. ................ 42 

Εικόνα 25: Options -> Add a new Cross Section. .................................................... 43 

Εικόνα 26: Προσδιορισμός γεωμετρικών χαρακτηριστικών της επόμενης και κάθε 

επόμενης διατομής. ................................................................................................. 43 

Εικόνα 27: Προσδιορισμός γεωμετρικών χαρακτηριστικών της τελικής  διατομής. . 44 

Εικόνα 28: File -> Save Geometry Data για αποθήκευση των χαρακτηριστικών της 

διατομής. ................................................................................................................. 44 

Εικόνα 29: Επιλογή αντίστοιχου φακέλου για αποθήκευση. .................................... 45 

Εικόνα 30: Steady Flow Data για εισαγωγή στοιχείων ροής..................................... 45 

Εικόνα 31: Καθορισμός παροχής Q ψηφιακού μοντέλου. ........................................ 46 



9  

Εικόνα 32: Reach Boundary Conditions για προσδιορισμό συνθηκών ροής ανάντι και 

κατάντι του καναλιού. ............................................................................................. 46 

Εικόνα 33: Προσδιορισμός μιας εκ των τεσσάρων επιλογών συνθήκης για τα δυο 

σημεία. .................................................................................................................... 47 

Εικόνα 34: File -> Save Flow Data για αποθήκευση συνθηκών ροής. ...................... 47 

Εικόνα 35: Επιλογή αντίστοιχου φακέλου για αποθήκευση. .................................... 48 

Εικόνα 36: Run -> Steady Flow Analysis. ............................................................... 48 

Εικόνα 37: Compute για εκκίνηση ψηφιακού μοντέλου. .......................................... 49 

Εικόνα 38: Εμφάνιση αξιολόγησης των εισαχθέντων δεδομένων. ............................ 49 

Εικόνα 39: Profile Plot για εμφάνιση του μοντέλου στον διαμήκη άξονα................. 50 

Εικόνα 40: Cross Section για εμφάνιση του μοντέλου στον εγκάρσιο άξονα. ........... 50 

Εικόνα 41: Cross Section Output προς ανάδειξη αποτελεσμάτων του μοντέλου σε 

κάθε διατομή. .......................................................................................................... 51 

Εικόνα 42: Profile Output Table προς ανάδειξη αποτελεσμάτων του μοντέλου 

συνολικά. ................................................................................................................ 51 

Εικόνα 43: Tools -> XS Interpolation-> Within a Reach για αύξηση των ενδιάμεσων 

διατομών ανάμεσα των χειροκίνητα τοποθετημένων. .............................................. 52 

Εικόνα 44: Καθορισμός ελάχιστης απόστασης μεταξύ των νέων διατομών κι 

εφαρμογή τους στο μοντέλο. ................................................................................... 52 

Εικόνα 45 File-> Save Geometry Data για αποθήκευση των νέων δεδομένων. ........ 53 

Εικόνα 46: Ροή υπεράνω ορθογωνικού αναβαθμού ................................................. 56 

Εικόνα 47: Μεγέθυνση στη στέψη του αναβαθμού .................................................. 56 

Εικόνα 48: Ροή υπεράνω ορθογωνικού αναβαθμού ................................................. 57 

Εικόνα 49: Μεγέθυνση στη στέψη του αναβαθμού .................................................. 58 

Εικόνα 50: Ροή υπεράνω τραπεζοειδούς αναβαθμού ............................................... 58 

Εικόνα 51: Μεγέθυνση στη στέψη του αναβαθμού .................................................. 59 

Εικόνα 52: Ροή υπεράνω τραπεζοειδούς αναβαθμού ............................................... 62 

Εικόνα 53: Μεγέθυνση στη στέψη του αναβαθμού .................................................. 62 

Εικόνα 54: Ροή υπεράνω τραπεζοειδούς αναβαθμού ............................................... 63 

Εικόνα 55: Μεγέθυνση στη στέψη του αναβαθμού .................................................. 63 

Εικόνα 56: Ανοικτός αγωγός και ροή υπό κλίση ...................................................... 64 

Εικόνα 57: Βάθη ροής κατά μήκος του αγωγού ....................................................... 64 

Εικόνα 58: Ροή υπεράνω κλιμακωτών θινών ........................................................... 65 

Εικόνα 59: Ροή υπεράνω θινών ύψους 0,25 m ......................................................... 67 



10  

Εικόνα 60: Μεγέθυνση της ροής στις θίνες .............................................................. 67 

Εικόνα 61: Ροή υπεράνω θινών ύψους 0,25 m ......................................................... 68 

Εικόνα 62: Μεγέθυνση της ροής στις θίνες .............................................................. 68 

 

Κατάλογος πινάκων 

 

Πίνακας 1: Γεωμετρικά χαρακτηριστικά αγωγών .................................................... 17 

Πίνακας 2: Τιμές Manning ...................................................................................... 24 

 

 

 

 

Κατάλογος διαγραμμάτων 

 

Διάγραμμα 1...............................................................Error! Bookmark not defined. 

Διάγραμμα 2............................................................................................................ 56 

Διάγραμμα 3...............................................................Error! Bookmark not defined. 

Διάγραμμα 4...............................................................Error! Bookmark not defined. 

Διάγραμμα 5...............................................................Error! Bookmark not defined. 

Διάγραμμα 6...............................................................Error! Bookmark not defined. 

Διάγραμμα 7...............................................................Error! Bookmark not defined. 

Διάγραμμα 8...............................................................Error! Bookmark not defined. 

Διάγραμμα 9...............................................................Error! Bookmark not defined. 

Διάγραμμα 10 .............................................................Error! Bookmark not defined. 

Διάγραμμα 11 .............................................................Error! Bookmark not defined. 

Διάγραμμα 12 .............................................................Error! Bookmark not defined. 

Διάγραμμα 13 .......................................................................................................... 66 

Διάγραμμα 14 .............................................................Error! Bookmark not defined. 

Διάγραμμα 15 .............................................................Error! Bookmark not defined. 

Διάγραμμα 16 .......................................................................................................... 67 

Διάγραμμα 17 .............................................................Error! Bookmark not defined. 

Διάγραμμα 18 .............................................................Error! Bookmark not defined. 

Διάγραμμα 19 .............................................................Error! Bookmark not defined. 



11  

Διάγραμμα 20 .............................................................Error! Bookmark not defined. 

Διάγραμμα 21 .............................................................Error! Bookmark not defined. 

Διάγραμμα 22 .............................................................Error! Bookmark not defined. 

Διάγραμμα 23 .............................................................Error! Bookmark not defined. 

Διάγραμμα 24 .............................................................Error! Bookmark not defined. 

Διάγραμμα 25 .............................................................Error! Bookmark not defined. 

 

 

 

Κατάλογος εξισώσεων 

 

(1) ........................................................................................................................... 19 

(2) ........................................................................................................................... 20 

(3) ........................................................................................................................... 21 

(4) ........................................................................................................................... 22 

(5) ........................................................................................................................... 22 

(6) ........................................................................................................................... 22 

(7) ............................................................................................................................ 23 

(8) ........................................................................................................................... 23 

(9) ........................................................................................................................... 26 

(10) ......................................................................................................................... 28 

(11) ......................................................................................................................... 59 

(12) ......................................................................................................................... 59 

(13) ......................................................................................................................... 59 

(14) ......................................................................................................................... 60 

(15) ......................................................................................................................... 60 

(16) ......................................................................................................................... 60 

(17) ......................................................................................................................... 60 

(18) ......................................................................................................................... 60 

(19) ......................................................................................................................... 60 

(20) ......................................................................................................................... 65 

 

Κατάλογος γραφημάτων 

Γράφημα 1: Ειδική ενέργεια .................................................................................... 23 



12  

1 Κεφάλαιο 1: Θεωρητικό υπόβαθρο  

 

1.1 Ορισμός Ρευστού – Το Συνεχές Μέσον 

 

Ορίζουμε ως ρευστό κάθε υλικό το οποίο παραμορφώνεται συνεχώς όταν 

υπόκειται σε διατμητική τάση, όσο μικρή και αν είναι αυτή. Λόγω της συνεχούς 

παραμορφώσεως, το ρευστό ρέει. Τα υγρά, όπως και τα αέρια είναι ρευστά. Λόγω της 

συνεχούς παραμορφώσεως (ροής), η συμπεριφορά του ρευστού ορίζεται από τη 

σχέση τάσεως – ρυθμού παραμορφώσεως. 

Ενώ το ρευστό έχει μοριακή δομή, στη ρευστομηχανική η δομή αυτή έχει 

αντικατασταθεί από ένα υποθετικό συνεχές μέσον. Αυτό επιτυγχάνεται με τη 

θεώρηση σφαίρας της οποίας η ακτίνα είναι μεγάλη σε σχέση με την μέση απόσταση 

των μορίων του ρευστού. Ο μικρότερος όγκος σφαίρας που περιέχει αρκετά μόρια 

ώστε να είναι δυνατή η προσομοίωση του ρευστού ως συνεχούς μέσου, ονομάζεται 

επιστημονικά ρευστό σωματίδιο. Επειδή οι τυπικές διαστάσεις ενός προβλήματος 

ρευστομηχανικής είναι πολύ μεγάλες σε σχέση με τις διαστάσεις ενός ρευστού 

σωματιδίου, μπορούμε να περιγράψουμε τις ιδιότητες του ρευστού ως συνεχείς 

συναρτήσεις στο χώρο και στο χρόνο. 

1.2 Ανοικτοί αγωγοί  

Ανοικτός αγωγός ή αγωγός ελεύθερης ροής είναι ένας αγωγός μέσα στον 

οποίο το νερό ρέει με ελεύθερη επιφάνεια.  Η πίεση στην επιφάνεια του νερού είναι 

σταθερή και ίση με την ατμοσφαιρική. Οι δυνάμεις που προκαλούν τη ροή στους 

ανοικτούς αγωγούς οφείλονται στη βαρύτητα, ενώ οι δυνάμεις που επιβραδύνουν τη 

ροή οφείλονται στην ιξώδη διάτμηση και στις τριβές κατά μήκος των τοιχωμάτων του 

αγωγού. 

Γενικά διακρίνονται δύο είδη ανοικτών αγωγών, οι τεχνητοί και οι φυσικοί 

αγωγοί, ανάλογα με την αρχική τους διαμόρφωση.  Οι φυσικοί ανοικτοί αγωγοί έχουν 

συνήθως διάφορες διατομές, με ακανόνιστα σχήματα και με μεγάλη ποικιλία 

τραχύτητας στα τοιχώματά τους.  Οι τεχνητοί αγωγοί επίσης έχουν διάφορες 

διατομές, αλλά είναι γνωστής γεωμετρίας και υλικών κατασκευής, ενώ η ποικιλία της 

τραχύτητας είναι μικρότερη.  Οι τεχνητοί αγωγοί ονομάζονται πρισματικοί όταν η 
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διατομή και η κλίση του πυθμένα τους είναι σταθερές. Οι πρισματικοί αγωγοί 

διακρίνονται σχηματικά σε ορθογωνικούς, τραπεζοειδείς, τριγωνικούς, ημικυκλικούς, 

παραβολικούς κ.λπ., ανάλογα με τα γεωμετρικά χαρακτηριστικά της διατομής τους. 

Για την ανάλυση των προβλημάτων των ανοικτών αγωγών απαιτείται η γνώση των 

διάφορων γεωμετρικών ιδιοτήτων της κατακόρυφης διατομής τους 

1.3 Τύποι Ανοικτών Αγωγών: Τεχνητοί και Φυσικοί 

Οι ανοικτοί αγωγοί είναι ζωτικής σημασίας για τη μεταφορά νερού από ένα 

σημείο σε άλλο και χρησιμοποιούνται ευρέως στη γεωργία, την ύδρευση και την 

αποστράγγιση. Υπάρχουν δύο κύριες κατηγορίες ανοικτών αγωγών: οι τεχνητοί και οι 

φυσικοί. Παρακάτω περιγράφονται οι κύριοι τύποι κάθε κατηγορίας. 

1.3.1 Φυσικοί Αγωγοί 

Ποτάμια 

Τα ποτάμια είναι φυσικοί αγωγοί που σχηματίζονται από τη φυσική ροή του 

νερού στην επιφάνεια της Γης και έχουν ποικίλα μεγέθη και μήκη. Έχουν δυναμικά 

χαρακτηριστικά ροής που επηρεάζονται από τη γεωμορφολογία, τις κλίσεις και τη 

βροχόπτωση. Η κοίτη κι οι διατομές τους μπορεί να είναι μεταβλητές και να 

αλλάζουν με την πάροδο του χρόνου λόγω της διάβρωσης και της απόθεσης 

ιζημάτων. Τέλος, η χρήση τους επικεντρώνεται σε άρδευση, ύδρευση, αναψυχή, 

παραγωγή ενέργειας. 

 

 

Εικόνα 1 : Κοίτη ποταμού Αχελώου 
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Ρέματα 

Θεωρούνται ως ρέματα οι παραπόταμοι μεγαλύτερων ποταμών, τα οποία 

εμφανίζουν εποχιακές μεταβολές στη ροή και μπορεί να στεγνώνουν κατά τη 

διάρκεια ξηρών περιόδων. Τέλος έχουν μικρότερο εύρος ροής σε σύγκριση με τα 

ποτάμια και εξειδικεύονται σε χρήση για τοπικές γεωργικές και οικιακές ανάγκες. 

 
 

Εικόνα 2: Ρέμα Πικροδάφνης 

 

Χείμαρροι 

Θεωρούνται τα υδατορεύματα που ρέουν κυρίως κατά την φθινοπωρινή και 

χειμερινή περίοδο. Έχουν έντονη ροή για μικρές χρονικές περιόδους και είναι 

επιρρεπείς σε πλημμύρες με χαρακτηριστικό την έντονη διάβρωση της κοίτης. Η 

κύρια χρήση τους, έτσι όπως έχει πλέον διαμορφωθεί είναι η αντιμετώπιση 

πλημμυρών. 
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Εικόνα 3: Χείμαρρος Σερρών 

 

1.3.2 Τεχνητοί Αγωγοί 

 

 

Εικόνα 4: Ρέμα Λευκάδας 
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Κανάλια Άρδευσης 

Είναι κατασκευασμένοι αγωγοί για τη μεταφορά νερού σε γεωργικές εκτάσεις 

και σχεδιάζονται για να έχουν ελεγχόμενη ροή και σταθερή παροχή νερού. 

Συνηθίζεται η επένδυση με υλικά όπως σκυρόδεμα για να μειωθούν οι απώλειες 

νερού, με αποκλειστική χρήση την άρδευση καλλιεργειών. 

Αποστραγγιστικά Κανάλια 

Για την αποστράγγιση των υδάτων από γεωργικές και κατοικημένες περιοχές 

κατασκευάζονται ειδικά αυτοί οι αγωγοί, οι οποίοι συχνά έχουν χαμηλότερες κλίσεις 

και μεγαλύτερο πλάτος για να μπορούν να αποστραγγίζουν μεγάλους όγκους νερού. 

Χρησιμοποιούνται στην αποστράγγιση εδάφους και συμβάλλουν δραστικά στην 

πρόληψη πλημμυρών. 

Διαμορφωμένοι Τάφροι 

  Κατασκευάζονται για την κατεύθυνση της απορροής του νερού όπου κρίνεται 

απαραίτητο. Συνήθως έχουν μικρότερο πλάτος και βάθος σε σύγκριση με τα μεγάλα 

κανάλια. Μπορούν να είναι επενδυμένοι ή μη, ανάλογα με την εφαρμογή και 

χρησιμεύουν συνήθως σε τοπικές αποστραγγίσεις. 

Οι πλέον συνηθέστερες μορφές διατομών ανοικτών αγωγών για μεταφορά 

νερού είναι: 

1.η ορθογωνική, 

2. η τριγωνική,  

3. η τραπεζοειδής,  

4. η κυκλική.  

Ενδεικτικά το σχήμα και τα γεωμετρικά χαρακτηριστικά τους  στον κάτωθι πίνακα: 
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Πίνακας 1: Γεωμετρικά χαρακτηριστικά αγωγών 

1.4 Ταξινόμηση ροών σε ανοικτούς αγωγούς 

 

Οι ροές υγρών σε αγωγούς, που χαρακτηρίζονται από την ύπαρξη ελεύθερης 

επιφάνειας, ονομάζονται «Ροές σε ανοικτούς αγωγούς». Στην ελεύθερη επιφάνεια το 

νερό βρίσκεται σε επαφή με τον ατμοσφαιρικό αέρα. Ο όρος «ροή με ελεύθερη 

επιφάνεια» είναι πιο γενικός από τον όρο «ροή σε ανοικτούς αγωγούς» και 

περιλαμβάνει, πέραν των ροών σε αγωγούς, τις ροές στην παράκτια ζώνη, τη μελέτη 

θαλάσσιων κυματισμών, τις ροές σε ειδικές βιομηχανικές διεργασίες και λοιπές 

διαδικασίες. 

Τα φαινόμενα που παρατηρούνται στις ροές σε ανοικτούς αγωγούς 

παρουσιάζουν ιδιαιτερότητες οι οποίες δεν απαντώνται στις ροές σε κλειστούς 

αγωγούς υπό πίεση. 

Για να συστηματοποιήσουμε τη μελέτη των ροών σε ανοικτούς αγωγούς 

ομαδοποιούμε τις ροές σε κατηγορίες με κριτήρια είτε κινηματικά - δηλαδή έχοντας 

κριτήριο το πώς μεταβάλλεται η ροή στον χρόνο και στον χώρο - είτε δυναμικά - 

δηλαδή έχοντας ως κριτήριο το σχετικό μέγεθος των δυνάμεων βαρύτητας και 

ιξώδους ως προς τις δυνάμεις αδράνειας – αντίστοιχα. 
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Από κινηματική άποψη διακρίνουμε τις εξής κατηγορίες ροών: 

1.4.1 Μόνιμη / Μη μόνιμη ροή 

 

Ο γενικός ορισμός της μόνιμης ή μη μόνιμης ροής στη Μηχανική Ρευστών 

ισχύει και στη μελέτη των ροών σε ανοικτούς αγωγούς. Επισημαίνεται ότι μια ροή 

ονομάζεται μόνιμη, όταν το πεδίο ταχύτητας της ροής είναι ανεξάρτητο του χρόνου 

και μη μόνιμη, όταν το πεδίο ταχύτητας είναι χρονοεξαρτημένο. 

Στις ροές σε ανοικτούς αγωγούς ο γενικός αυτός ορισμός εξειδικεύεται και 

εκφράζεται ως συνθήκη βάθους της ροής, μια ποσότητα που παίζει κομβικό ρόλο στη 

μελέτη της ροής σε ανοικτούς αγωγούς. Μια ροή σε ανοικτό αγωγό ονομάζεται 

μόνιμη όταν το βάθος της ροής σε κάθε διατομή του αγωγού είναι ανεξάρτητο του 

χρόνου, δηλαδή παραμένει αμετάβλητο (σταθερό) στον χρόνο. Συνεπάγεται ότι το 

εμβαδόν της υγρής διατομής είναι ανεξάρτητο του χρόνου και επομένως για δεδομένη 

σταθερή παροχή συνάγεται ότι και η μέση ταχύτητα σε τυχαία διατομή είναι επίσης 

ανεξάρτητη του χρόνου. 

Αντίθετα, όταν το βάθος της ροής μεταβάλλεται με τον χρόνο, η μέση 

ταχύτητα στη διατομή μεταβάλλεται επίσης με τον χρόνο και η ροή ονομάζεται μη 

μόνιμη. 

1.4.2 Ομοιόμορφη ροή  

 

Στην περίπτωση που η ροή θεωρείται ομοιόμορφη , ισχύουν ότι οι γραμμές 

ροής είναι ευθείες και παράλληλες προς τον πυθμένα του αγωγού. Αναφέρεται, ότι η 

ελεύθερη επιφάνεια αποτελεί γραμμή ροής και διαμορφώνεται παράλληλα με τον 

πυθμένα του καναλιού. Η κατανομή της πίεσης είναι υδροστατική σε κάθε διατομή 

του αγωγού. Η κλίση του πυθμένα  είναι ίδια με την κλίση της γραμμής ενέργειας. 

Στη μόνιμη ομοιόμορφη ροή το βάθος της ροής είναι εξ ορισμού αμετάβλητο 

κατά μήκος του αγωγού. Για να αναπτυχθεί ομοιόμορφη ροή, ο αγωγός πρέπει να 

είναι ευθύγραμμος, να έχει σταθερή διατομή και σταθερή κατά μήκος κλίση και η  

τραχύτητα του τοιχώματος να παραμένει αμετάβλητη κατά μήκος του αγωγού. Οι 

συνθήκες αυτές πρέπει να ικανοποιούνται σε μεγάλο μήκος του αγωγού, ώστε η ροή 

να αναπτυχθεί και να φθάσει στο όριο της ομοιόμορφης ροής. 
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Eίναι κατανοητό ότι το βάθος και η ταχύτητα της ροής μεταβάλλονται, γενικά, 

κατά μήκος ενός ανοικτού αγωγού και ότι οι συνθήκες της ομοιόμορφης ροής σπάνια 

επιτυγχάνονται στην πράξη. Η παρεμβολή κάποιου εμποδίου - αναβαθμού στη ροή 

(π.χ. φράγματος, εκχειλιστή, ρυθμιστικού θυροφράγματος) ή η αλλαγή της κλίσης 

του αγωγού είναι οι συνήθεις αιτίες δημιουργίας μεταβαλλόμενης ροής, ακόμη και 

όταν η γεωμετρία της διατομής του αγωγού παραμένει αμετάβλητη.  

 

1.5 Ενέργεια  

 

1.5.1 Γραμμή Ενέργειας  

 

Η Γραμμή Ενέργειας (ΓΕ), στα αγγλικά Energy Grade Line (EGL), είναι ο 

γεωμετρικός τόπος του ολικού φορτίου, κατά μήκος του αγωγού. Σε θέσεις (διατομές) 

όπου υπάρχουν τοπικές απώλειες, η ΓΕ παρουσιάζει τοπική πτώση ίση με το φορτίο 

τοπικών απωλειών. Σε τμήματα αγωγού με σταθερή διάμετρο, η ΓΕ παρουσιάζει 

σταθερή, πτωτική κλίση ίση με 
ℎ𝑓

𝐿
 όπου hf το φορτίο τοπικών απωλειών και L το 

μήκος του αγωγού. Το ύψος της Γραμμής Ενέργειας υπολογίζεται ως εξής:  

 

 

H = 
𝑃

𝛾
 + z + 

𝑉2

2𝑔
  

(1) 

 

1.5.2 Πιεζομετρική Γραμμή  

 

Η Πιεζομετρική Γραμμή (ΠΓ), στα αγγλικά Hydraulic Grade Line (HGL), 

είναι ο γεωμετρικός τόπος του πιεζομετρικού φορτίου, κατά μήκος του αγωγού.  Για 

αγωγούς σταθερής διαμέτρου, η ΠΓ είναι παράλληλη με την ΓΕ και ευρίσκεται κάτω 

απ' αυτήν κατά  
𝑉2

2𝑔
.  Σε τμήματα αγωγού με σταθερή διάμετρο, η ΠΓ παρουσιάζει 

σταθερή, πτωτική κλίση ίση με  
ℎ𝑓

𝐿
, ενώ ορίζεται ως: 
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h = 
𝑃

𝛾
+ 𝑧 

(2) 

Επεξηγηματικά όπου:  

P : η πίεση στην εκάστοτε διατομή  

γ : το ειδικό βάρος  

 z : το ύψος του αγωγού από το επίπεδο αναφοράς  

V : η ταχύτητα  

 

 

Εικόνα 5: Ενέργεια ροής 

 

1.5.3 Στρωτή και Τυρβώδης Ροή 

 

Στη στρωτή ροή, στρώματα ρευστού απειροελάχιστου πάχους ολισθαίνουν επ' 

αλλήλων και υπόκεινται σε διάτμηση που περιγράφεται από το νόμο του ιξώδους του 

Νεύτωνα. Αν εισαχθεί διαταραχή στη ροή (π.χ. λόγω τραχύτητας των τοιχωμάτων), 

παρατηρείται απόσβεσή της λόγω της δράσεως του ιξώδους. 

Στη τυρβώδη ροή, μάζες ρευστού κινούνται προς όλες τις κατευθύνσεις με 

κλίμακες μήκους μεγάλου εύρους τιμών. Οι κινήσεις αυτές ονομάζονται στρόβιλοι ή 

δίνες. 
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2 Κεφάλαιο 2: Έννοιες και εξισώσεις 

 

2.1 Αριθμός Froude  

 

Η ταξινόμηση (κατηγοριοποίηση) των ροών σε ανοικτούς αγωγούς μπορεί να 

εκφρασθεί με βάση τον αδιάστατο αριθμό Froude ως: 

 

Fr = 
𝑉

√𝑔 𝑦
  

(3) 

για αγωγούς ορθογωνικής διατομής: 

Όπου:  

V : η ταχύτητα  

y : το βάθος ροής  

 

 

 <1      υποκρίσιμη ροή 

                                 Fr               =1      κρίσιμη ροή 

                                                   >1      υπερκρίσιμη ροή 

 

 

O αριθμός Froude είναι πολύ χρήσιμος στην περιγραφή της συμπεριφοράς 

των ροών ομογενών υγρών σε ανοικτούς αγωγούς. Όταν η ροή είναι υποκρίσιμη, το 

νερό κινείται με μικρή ταχύτητα. Τα κύματα που δημιουργούνται στην ελεύθερη 

επιφάνεια εξαιτίας μιας διαταραχής, διαδίδονται με ταχύτητα μεγαλύτερη από την 

ταχύτητα του νερού και, επομένως, οι κυματισμοί μπορούν να κινηθούν ανάντη και 

κατάντη. Κατά συνέπεια, οι κατάντι συνθήκες επηρεάζουν την ανάντη ροή και, 

επομένως, η υποκρίσιμη ροή ελέγχεται από τις κατάντη συνθήκες. Όταν η ροή είναι 

υπερκρίσιμη, το υγρό κινείται με μεγάλη ταχύτητα. Τα επιφανειακά κύματα που 

τυχόν δημιουργούνται, διαδίδονται με μικρότερη ταχύτητα από ότι το νερό και, 
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επομένως, τα κύματα κινούνται μόνο κατάντη. Επομένως, η υπερκρίσιμη ροή 

ελέγχεται από τις ανάντη συνθήκες.  

2.2 Αρχή διατήρησης της μάζας (εξίσωση συνέχειας) 

 

Όταν η ροή είναι μόνιμη και ασυμπίεστη, η αρχή διατήρησης της μάζας 

λαμβάνει την απλή μορφή:  

Q = V A 

(4) 

 

 

2.3 Αρχή διατήρησης της ορμής 

 

Στη μονοδιάστατη προσέγγιση μόνιμης ροής παίρνει τη μορφή: 

ΣF = ρ Q (VB – VA) 

(5) 

Όπου :  

Q : η παροχή 

ρ : η πυκνότητα  

A : το εμβαδόν  

V : η ταχύτητα  

 

 

2.4 Αρχή διατήρησης της ενέργειας (εξίσωση ενέργειας) 

 

Θεωρώντας δύο διατομές του αγωγού, η εξίσωση ενέργειας γράφεται σε 

συνεπτυγμένη μορφή ως: 

 

HA - HB = Hloss 

(6) 
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όπου η διατομή Β είναι κατάντη της διατομής Α και Ηloss είναι η απώλεια 

ενεργειακού ύψους λόγω τριβής μεταξύ των δύο διατομών. 

 Αναλυτικά, η εξίσωση ενέργειας (στη μονοδιάστατη ανάλυση) γράφεται ως: 

 

zA + hA + aA 
𝑉𝐴2

2𝑔
 = zB + hB + aB 

𝑉𝐵2

2𝑔
 + Hloss 

(7) 

 

 

Γράφημα 1: Ειδική ενέργεια 

2.5 Συντελεστής Manning 

 

Ο συντελεστής Manning αποτελεί, από πρακτική άποψη, ένα μέτρο της 

τραχύτητας των τοιχωμάτων του ανοικτού αγωγού και συμβολίζεται ως συντελεστής 

n. Στην πραγματικότητα, η τιμή του συντελεστή Manning εξαρτάται από ένα πλήθος 

παραγόντων κυριότερος των οποίων είναι η τραχύτητα του τοιχώματος και ορίζεται 

ως εξής:  

Q = 
1

𝑛
  A 𝑅ℎ

2/3
 𝑆𝑓

1/2
 

(8) 

Όπου :  
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 Q = V A  

 Rh = 
𝐴

𝑃
 με Α: εμβαδόν και Ρ: βρεχόμενη περίμετρος  

 Sf : κλίση πυθμένα  

 

 

Ενδεικτικά, οι τιμές που χρησιμοποιούνται ευρέως για τον υπολογισμό της 

εξίσωσης Manning βασίζονται στις μέσες τιμές του συντελεστή n, οι οποίες 

παραθέτονται παρακάτω:  

 

 

Επενδεδυμένες διώρυγες

Ύαλος (γυαλί) 0.01

Επίχρισμα τσιμέντου 0.011

Χάλυβας, λείος 0.012

Χάλυβας, ηλωτός 0.015

Χυτοσίδηρος 0.013

Σκυρόδεμα με επίχρισμα 0.012

Σκυρόδεμα (τραχείς ξυλότυποι) 0.0165

Πλανισμένο ξύλο 0.012

Πλινθοδομή 0.015

Άσφαλτος 0.016

Κυματοειδές μέταλλο 0.022

Αργολιθοδομή 0.025

Ανεπένδυτες τάφροι

καθαρές 0.022

χαλικώδεις 0.025

χορταριασμένες 0.03

βραχώδεις, με κροκάλες 0.035

Φυσικά υδατορεύματα

Ευθύγραμμα και καθαρά 0.03

Νωθρά, ήρεμα 0.04

Μεγάλοι ποταμοί 0.035

Φυσικά ρεύματα με βλάστηση και ανώμαλες επιφάνειες 0.05

Πλημμυρικές κοίτες

Χορτολιβαδική γη, γεωργική γη 0.035

Ελαφρώς θαμνώδεις 0.05

Αισθητά θαμνώδεις 0.075

Δενδρώδεις 0.15  

Πίνακας 2: Τιμές Manning 
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2.6 Υδραυλικό άλμα  

 

Το υδραυλικό άλμα είναι ένα χαρακτηριστικό φαινόμενο των ροών με 

ελεύθερη επιφάνεια και παρατηρείται όταν μια ροή μεταπίπτει από συνθήκες 

υπερκρίσιμης ροής (Fr >1) σε συνθήκες υποκρίσιμης ροής (Fr <1). Σημειώνεται ότι η 

μετάβαση της ροής από υποκρίσιμη σε υπερκρίσιμη γίνεται κατά ομαλό τρόπο, 

δηλαδή με ομαλή μείωση της στάθμης της ελεύθερης επιφάνειας και αύξηση της 

ταχύτητας. Αντίθετα, η μετάβαση από υπερκρίσιμη σε υποκρίσιμη ροή γίνεται 

πάντοτε απότομα, σε σχετικά μικρό μήκος του αγωγού, και συνδέεται με έντονους 

στροβιλισμούς και σημαντική απώλεια μηχανικής ενέργειας. Το υδραυλικό άλμα 

είναι μια σημαντική περίπτωση ανομοιόμορφης και ταχέως μεταβαλλόμενης ροής, 

σύμφωνα με την ταξινόμηση των ροών σε ανοικτούς αγωγούς.  

Από ενεργειακή άποψη, το υδραυλικό άλμα λειτουργεί ως αποτελεσματικός 

καταστροφέας της κινητικής ενέργειας της ροής. Η απώλεια ενεργειακού ύψους Hloss 

οφείλεται στη διασκόρπιση (καταστροφή) της κινητικής ενέργειας της ροής, λόγω 

των έντονων στροβιλισμών και της τύρβης εντός του υδραυλικού άλματος. Το ύψος 

των απωλειών ενέργειας, Ηloss, είναι ένα μέγεθος που επιδιώκουμε να 

προσδιορίσουμε.  

 

 

 

Εικόνα 6: Υδραυλικό άλμα 

 

Όταν η διατομή του αγωγού είναι ορθογωνική τότε το υδραυλικό άλμα υπολογίζεται 

ως εξής: 
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𝑦2

𝑦1
 = 

1

2
 ( √1 + 8𝐹𝑟1

2 - 1) 

(9) 

2.6.1 Τύποι Υδραυλικών Αλμάτων  

 

Τα υδραυλικά άλματα σε οριζόντιους αγωγούς ορθογωνικής διατομής 

ταξινομούνται σε 5 κατηγορίες σύμφωνα με τους Bradley και Peterka, (έρευνα 1957) 

βάσει του FrΑ της ανάντη υπερκρίσιμης ροής: 

 

 Κυματοειδές άλμα για 1 < FrΑ  <1,7. Η ελεύθερη επιφάνεια έχει κυματισμούς 

και οι απώλειες ενέργειας είναι αμελητέες.  

 

Εικόνα 7: Κυματοειδές άλμα 

 

 Ασθενές άλμα για 1,7< FrΑ <2,5. Μια σειρά κυλιόμενων σχηματισμών 

αναπτύσσεται στην επιφάνεια του άλματος και η ελεύθερη επιφάνεια κατάντη 

του άλματος είναι λεία. Οι απώλειες ενέργειας είναι μικρές.  

 

Εικόνα 8: Ασθενές άλμα 

 Ταλαντούμενο άλμα για 2,5 < FrΑ <4,5. Η εισερχόμενη φλέβα ύδατος 

ταλαντώνεται με τυχαίο τρόπο μεταξύ του πυθμένα και της ελεύθερης 

επιφάνειας, δημιουργώντας επιφανειακά κύματα τα οποία διατηρούνται σε 
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σημαντική απόσταση στα κατάντη και τα οποία μπορεί να προκαλέσουν 

διάβρωση στις όχθες.  

 

Εικόνα 9: Ταλαντούμενο άλμα 

 

 Σταθερό άλμα για 4,5 < FrΑ <9. Το κατάντη πέρας του επιφανειακού 

σχηματισμού και η θέση στην οποία η εισερχόμενη φλέβα τείνει να 

αποκολληθεί από τον πυθμένα ευρίσκονται περίπου επί του ιδίου 

κατακορύφου επιπέδου. Οι απώλειες ενέργειας κυμαίνονται από 45% μέχρι 

70%. 

 

Εικόνα 10: Σταθερό άλμα 

 

 Ισχυρό άλμα για 9< FrΑ. Η ελεύθερη επιφάνεια είναι πολύ τραχεία. Η θέση 

στην οποία η εισερχόμενη φλέβα τείνει να αποκολληθεί από τον πυθμένα 

βρίσκεται στα ανάντη του κατάντη πέρατος του επιφανειακού σχηματισμού. 

Η δράση του άλματος είναι τραχειά αλλά αποτελεσματική.  

 

Εικόνα 11:Ισχυρό άλμα 
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2.6.2 Μήκος υδραυλικού άλματος 

 

Το μήκος ορίζεται ως η απόσταση μεταξύ του μετώπου του άλματος και του 

πέρατος του επιφανειακού σχηματισμού.  

 

 

2.7 Διατομή ελέγχου  

 
Ως διατομή ελέγχου ορίζεται κάθε διατομή ροής όπου η σχέση στάθμης – παροχής 

είναι καθορισμένη. Άρα διατομή ελέγχου είναι και η διατομή στην οποία η ροή είναι κρίσιμη. 

Σύμφωνα με την συνθήκη κρίσιμης ροής:  

 

𝑄2 𝐵 𝑦𝑐

𝑔 𝐴 𝑦𝑐
3
 = 1, 

(10) 

 όταν η ροή είναι κρίσιμη, η παροχή είναι συνάρτηση μόνο του βάθους. Οι διατομές ελέγχου 

χρησιμοποιούνται για τη μέτρηση της παροχής στους ανοικτούς αγωγούς. Όταν δεν υπάρχει 

φυσική διατομή ελέγχου συχνά σε δεδομένη διατομή δημιουργούμε συνθήκες κρίσιμης ροής 

με μεταβολή της διατομής, είτε μέσω υπερυψώσεως του πυθμένα, είτε με προσθήκη εμποδίου  

ή μέσω ελαττώσεως του πλάτους ή συνδυαστικά. 

2.8 Αναβαθμοί 

 

Ένας αναβαθμός ή εμπόδιο χαμηλής κεφαλής είναι μια κατασκευή που 

εκτείνεται σε όλο το πλάτος ενός ποταμού, αλλάζοντας τα χαρακτηριστικά της ροής 

του νερού και προκαλώντας συνήθως αλλαγή στο ύψος της στάθμης του ποταμού. Οι 

αναβαθμοί χρησιμοποιούνται επίσης για τη ρύθμιση της ροής του νερού σε εξόδους 

λιμνών, λεκανών απορροής και δεξαμενών. Επεξηγηματικά, συνήθως το νερό ρέει 

ελεύθερα πάνω από την κορυφή του αναβαθμού πριν καταλήξει σε καταρράκτη σε 

χαμηλότερο επίπεδο. 

Οι αναβαθμοί χρησιμοποιούνται συνήθως για την πρόληψη πλημμυρών, τη 

μέτρηση της παροχής νερού και τη βελτίωση της πλεύσιμης δυνατότητας των 

ποταμών. Σε ορισμένες περιοχές, οι όροι "φράγμα" και "αναβαθμός" 



29  

χρησιμοποιούνται ως συνώνυμα, αλλά συνήθως υπάρχει σαφής διάκριση μεταξύ των 

δύο κατασκευών. Συνήθως, ένα φράγμα σχεδιάζεται ειδικά για την αποθήκευση 

νερού πίσω από έναν τοίχο, ενώ ένας αναβαθμός έχει ως στόχο να αλλάξει τα 

χαρακτηριστικά ροής ενός ποταμού. 

Μια κοινή διάκριση μεταξύ φραγμάτων και αναβαθμών είναι ότι το νερό ρέει 

πάνω από την κορυφή (ή τη στέψη) ενός αναβαθμού ή κάτω από αυτόν για 

τουλάχιστον κάποιο μήκος του. Συνεπώς, η κορυφή μιας υπερχειλιστικής διάβασης 

σε ένα μεγάλο φράγμα μπορεί να αναφέρεται ως αναβαθμός. Οι αναβαθμοί μπορεί να 

ποικίλουν σε μέγεθος, τόσο οριζόντια όσο και κάθετα, με τους μικρότερους να έχουν 

ύψος λίγων εκατοστών, ενώ οι μεγαλύτεροι μπορεί να είναι πολλών μέτρων σε ύψος 

και εκατοντάδων μέτρων σε μήκος, εξαρτώμενοι πάντα από την χρήση για την οποία 

ορίζονται. 

Η χρήση αναβαθμών και εμποδίων σε ανοικτούς αγωγούς αποτελεί μια 

σημαντική πρακτική στη διαχείριση υδάτινων πόρων. Αυτές οι κατασκευές 

προσφέρουν πολλαπλά οφέλη, τόσο για το περιβάλλον όσο και για τις ανθρώπινες 

δραστηριότητες 

Μία από τις βασικότερες χρήσεις των αναβαθμών και των εμποδίων είναι ο 

έλεγχος της ροής του νερού. Με την τοποθέτηση κλιμακωτών αναβαθμών και άλλων 

εμποδίων, επιτυγχάνεται η ρύθμιση της στάθμης του νερού σε κανάλια και ποτάμια. 

Αυτό είναι κρίσιμο για την προστασία των παρακείμενων περιοχών από πλημμύρες, 

ειδικά κατά τη διάρκεια περιόδων έντονων βροχοπτώσεων που αυξάνεται η παροχή. 

Επιπλέον, τα εμπόδια επιβραδύνουν τη ροή του νερού, μειώνοντας έτσι τη διάβρωση 

των κοιτών και των όχθεων των ποταμών. 

Ένας άλλος σημαντικός ρόλος των αναβαθμών είναι η μέτρηση της ροής του 

νερού. Υδρομετρικοί αναβαθμοί, όπως οι κλιμακωτοί, οι τραπεζοειδείς και οι 

τριγωνικοί αναβαθμοί, χρησιμοποιούνται για την ακριβή καταγραφή της ροής και τον 

υπολογισμό των διαφόρων μεγεθών. 

 

Παραδείγματα αναβαθμών που χρησιμοποιούνται συχνά σε ανοικτούς αγωγούς: 
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Εικόνα 12: Ορθογωνικός αναβαθμός 

 

 

 

Εικόνα 13: Τραπεζοειδής αναβαθμός 

 

2.8.1 Πλεονεκτήματα των Αναβαθμών και Εμποδίων 

Η χρήση αναβαθμών και εμποδίων σε ανοικτούς αγωγούς προσφέρει 

πληθώρα πλεονεκτημάτων. 

  Ένα από τα σημαντικότερα είναι αρχικά, η προστασία από πλημμύρες. Με τη 

ρύθμιση της στάθμης του νερού και τη δημιουργία δεξαμενών αποθήκευσης, 

μειώνεται ο κίνδυνος πλημμυρών, προστατεύοντας έτσι τις παρακείμενες περιοχές 

και τις κατοικίες. 

Επιπλέον, τα εμπόδια και οι αναβαθμοί προλαμβάνουν (ή περιορίζουν) τη 

διάβρωση. Η μείωση της ταχύτητας του νερού προστατεύει την κοίτη και τις όχθες 
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των ποταμών και των καναλιών, διατηρώντας τη σταθερότητα του εδάφους και 

προωθώντας την ανάπτυξη της βλάστησης. 

Οι αναβαθμοί και τα εμπόδια συμβάλλουν επίσης στην προστασία και 

ενίσχυση της βιοποικιλότητας. Η επιβράδυνση της ροής και η δημιουργία ήρεμων 

νερών ευνοούν την ανάπτυξη υδροβιοτόπων, προσφέροντας καταφύγιο για πολλά 

είδη ζώων και φυτών. Επιπλέον, η καθίζηση των ιζημάτων σε περιοχές με μειωμένη 

ροή βελτιώνει την ποιότητα του νερού που ρέει. 

Τέλος, οι αναβαθμοί και τα εμπόδια προσφέρουν σημαντικά κοινωνικά και 

οικονομικά οφέλη. Οι περιοχές γύρω από φράγματα και υγρότοπους μπορούν να 

αναπτυχθούν ως τουριστικοί προορισμοί, προσφέροντας οικονομικά οφέλη στις 

τοπικές κοινότητες. Επιπλέον, η σταθερή παροχή νερού για άρδευση βελτιώνει τη 

γεωργική παραγωγή και την ασφάλεια τροφίμων, ενισχύοντας την τοπική οικονομία. 

 

2.9 Σχηματισμός θινών λόγω επίδρασης ανέμου 

Ο αμμόλοφος, ή αλλιώς θίνα, είναι ένας λόφος από άμμο που δημιουργείται 

μέσω της δράσης του ανέμου ή του νερού. Οι αμμόλοφοι συνήθως έχουν ήπια κλίση 

στην πλευρά που χτυπάει ο άνεμος, όπου η άμμος ωθείται προς τα πάνω στη θίνα, και 

πιο απότομοι στην προστατευμένη πλευρά. Οι θίνες εμφανίζονται, για παράδειγμα, σε 

κάποιες έρημες περιοχές ή κατά μήκος των ακτών. Οι παράκτιες θίνες έχουν έναν 

σημαντικό ρόλο στην προστασία της γης από τα κύματα που προκαλούν οι 

καταιγίδες, λειτουργώντας αποσβεστικά. 

Οι αμμόλοφοι είναι γεωμορφολογικά χαρακτηριστικά που δημιουργούνται 

μέσω της συσσώρευσης άμμου από τον άνεμο. Η διαδικασία ξεκινά όταν ο άνεμος 

εναποθέτει άμμο σε ένα συγκεκριμένο σημείο, δημιουργώντας έναν μικρό τύμβο. 

Καθώς ο άνεμος συνεχίζει να φυσάει, η άμμος συσσωρεύεται στην προσήνεμη 

πλευρά του τύμβου μέχρι να καταρρεύσει η άκρη του λόγω του βάρους της. Η 

κατάρρευση καθορίζει το τελικό σχήμα της και συμβαίνει όταν η γωνία του 

αμμόλοφου ξεπεράσει τη γωνία ανάπαυσης, η οποία κυμαίνεται συνήθως μεταξύ 30 

και 34 μοιρών, ανάλογα με παράγοντες όπως το μέγεθος και η στρογγυλότητα των 

κόκκων άμμου, καθώς και η ταχύτητα του ανέμου. 



32  

 

 

Εικόνα 14: Μορφολογία θινών 

 

2.10 Σχηματισμός θινών σε πυθμένα ανοικτού αγωγού  

 

Συμπληρωματικά, θίνες παρουσιάζονται όχι μόνο εξαιτίας της επίδρασης του 

ανέμου σε χερσαίες εκτάσεις, αλλά και σε περιοχές όπου είναι έντονη η επίδραση του 

νερού λόγω της ροής του. Η βασική αιτία για την δηµιουργία αµµωδών 

σχηµατισµών, στους πυθµένες των ανοιχτών αγωγών που καταλαµβάνονται από 

µαλακά ιζήµατα, είναι η  στερεοµεταφορά. Συγκεκριµένα, η διατµητική τάση που 

αναπτύσσεται κατά µήκος του πυθµένα του καναλιού λόγω της ροής, οδηγεί σε 

αποκόλληση και αιώρηση του χαλαρού υλικού του, µε αποτέλεσµα τον σχηµατισµό 

διαφόρων τύπων πυθµένα. Το υλικό του πυθµένα µπορεί να μετακινείται µε δύο 

διαφορετικούς τρόπους, σαν φορτίο κλίνης ή σε αιώρηση. Σε ήπιους αριθµούς 

Froude, το φορτίο κλίνης είναι ο κύριος µηχανισµός µεταφοράς του ιζήµατος, και 

υπό αυτό το καθεστώς έχουµε την δηµιουργία σχηµατισµών µορφής ρυτίδων ή 

θινών.  

Σε υψηλότερες συνθήκες ροής, όπου στον πυθµένα αναπτύσσονται µορφές 

αντί-θινών, το ίζηµα µεταφέρεται κυρίως σε αιώρηση. Η µεταφορά του ιζήµατος δεν 

είναι συνεχής αλλά πάνω από ένα αρκετά σηµαντικό τµήµα του πυθµένα η διεύθυνσή 
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του αντιστρέφεται. Γενικά, η µετακίνηση του ιζήµατος εξαρτάται από το σχηµατισµό 

του ολκού στο υπήνεµο τµήµα της γεωµετρίας του πυθµένα σε συνδυασµό µε τις 

τοπικές τυρβώδεις διαταραχές καθώς και την τοπική αντίσταση.  Όταν το κατώφλι 

της µετακίνησης του ιζήµατος ξεπεραστεί τότε εντελώς τυχαία είναι δυνατόν να 

δηµιουργηθεί ένας µικρός σωρός από ίζηµα σε κάποια θέση του πυθµένα 

δηµιουργώντας εκεί µια τοπική διαταραχή. Η διαταραχή αυτή δηµιουργεί στον 

επίπεδο πυθµένα ένα είδος διεπιφάνειας ή επιφάνειας ασυνέχειας στη ροή παρόµοια 

µε εκείνη που δηµιουργείται στη ροή πάνω από αναβαθµό ή καταβαθµό.  

Στη διατµητική ροή αυτής της διεπιφάνειας η ένταση της τύρβης είναι αρκετά 

υψηλή και οι κόκκοι του ιζήµατος προωθούνται προς τα πάνω αναµειγνυόµενοι µε το 

ρευστό λόγω των τυρβωδών διαταραχών  που συµβαίνουν κυρίως στο σηµείο όπου 

επανακολλάται η ροή πίσω από το σωρό του ιζήµατος. Κατάντη του σηµείου 

επανακόλλησης της ροής, οι τυρβώδεις διαταραχές µειώνονται και βαθµιαία 

αναπτύσσεται ένα είδος οριακού στρώµατος. Η µέση διάτµηση, που παρέχει τη 

δύναµη για την µεταφορά των κόκκων του ιζήµατος, είναι µηδενική στο σηµείο 

επανακόλλησης της ροής και αυξάνει στην κατάντη διεύθυνση. Λόγω της µείωσης 

των διαταραχών µετά το σηµείο επανακόλλησης κάποιο από το υλικό του ιζήµατος 

που βρίσκονταν σε κίνηση δεν µπορεί πλέον να διατηρηθεί σε διαταραχή και 

µεταφέρεται προς τα κατάντη δηµιουργώντας έτσι µετά την πτώση του έναν δεύτερο 

σωρό από ίζηµα. Η διαδικασία αυτή (µηχανισµός - σχηματισμός) συνεχίζεται µέχρι 

που δηµιουργούνται οι πρώτοι σχηµατισµοί πάνω στον επίπεδο πυθµένα του 

καναλιού (Raudkivi, 1966). Ο µηχανισµός δηµιουργίας των αµµωδών θινών (dunes) 

φαίνεται στα παρακάτω υδραυλικά μοντέλα, που αναφέρονται σε επόμενο κεφάλαιο.  

Βασική παράµετρος για τον σχηµατισµό και την διάδοσή τους κατάντη του 

καναλιού είναι ένα είδος στροβίλου στερεού ιζήµατος που ξεκινά ακριβώς από το 

σηµείο αποκόλλησης της ροής και ανεβαίνει προς την ελεύθερη επιφάνειά της. Ο 

στρόβιλος αυτός που εµφανίζεται στην ελεύθερη επιφάνεια σαν αναμόχλευση της 

ροής, µεταφέρεται κατάντη από τη µέση ροή και καταστρέφεται αφήνοντας το υλικό 

του ιζήµατος που µεταφέρει να πέσει σε κατάντη σηµείο του πυθµένα. Η διαδικασία 

αυτή συνεχίζεται έως τον τελικό σχηµατισµό της µορφολογίας των θινών.   
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3 Κεφάλαιο 3: HEC RAS  

 

3.1 Περιγραφή του υδραυλικού μοντέλου  

Το HEC-RAS (Hydrologic Engineering Centers River Analysis System) είναι 

ένα λογισμικό που αναπτύχθηκε από το Hydrologic Engineering Center (HEC) του 

U.S. Army Corps of Engineers. Αποτελεί ένα από τα πιο σημαντικά εργαλεία στη 

μηχανική υδραυλικών έργων και χρησιμοποιείται ευρέως για την ανάλυση και 

προσομοίωση ροής ποταμών και ρευμάτων. 

3.2 Ανάπτυξη και Ιστορικό 

Το HEC-RAS ξεκίνησε να αναπτύσσεται τη δεκαετία του 1980 από το 

Hydrologic Engineering Center, που είναι τμήμα του U.S. Army Corps of Engineers. 

Ο κύριος στόχος ήταν η δημιουργία ενός εργαλείου που να μπορεί να ενσωματώνει 

και να επεξεργάζεται δεδομένα υδραυλικής ανάλυσης, προσφέροντας πιο ακριβείς 

και αξιόπιστες προβλέψεις για τη διαχείριση υδάτινων πόρων. 

Το πρώτο επίσημο release του HEC-RAS έγινε το 1995 και έκτοτε έχει 

υποστεί πολλές βελτιώσεις και αναβαθμίσεις. Σήμερα, το λογισμικό είναι στην 

έκδοση 6.4.1, η οποία περιλαμβάνει σημαντικές επεκτάσεις και βελτιώσεις στη 

λειτουργικότητα και τις δυνατότητές του. 

3.3 Τι Είναι το HEC-RAS 

Το HEC-RAS είναι ένα σύστημα μοντελοποίησης υδραυλικής ανάλυσης που 

επιτρέπει την προσομοίωση ροής νερού σε ποτάμια, κανάλια και άλλα υδατορέματα. 

Προσφέρει δυνατότητες για: 

1. Μοντελοποίηση μονοδιάστατης (1D) και δισδιάστατης (2D) ροής: Αυτό 

περιλαμβάνει τη ροή σε φυσικά και τεχνητά κανάλια. 

2. Ανάλυση πλημμυρών και διαχείριση πλημμυρικών κινδύνων: Προβλέπει 

την έκταση και το βάθος των πλημμυρών, παρουσιάζοντας αναλυτικά τα 

αποτελέσματα, βοηθώντας στη λήψη αποφάσεων για μέτρα αντιμετώπισης και 

προστασίας. 
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3. Διαχείριση και προσομοίωση αλλαγών στις υποδομές: Επιτρέπει την 

αξιολόγηση της επίδρασης νέων κατασκευών, όπως γέφυρες, φράγματα και 

αναβαθμούς. 

4. Υδραυλική ανάλυση αστικών και αγροτικών περιοχών: Χρησιμοποιείται 

για τη μελέτη της απορροής και της αποστράγγισης σε διάφορα περιβάλλοντα. 

3.4 Εφαρμογές του HEC-RAS 

1. Μελέτες Πλημμυρών και Σχεδιασμός Προστασίας. Το HEC-RAS 

χρησιμοποιείται εκτενώς για τη μελέτη των πλημμυρών. Μπορεί να 

προβλέψει την έκταση των πλημμυρών και να βοηθήσει στη λήψη μέτρων για 

την προστασία των περιοχών που κινδυνεύουν. Για παράδειγμα, μπορεί να 

εκτιμήσει τις πλημμυρικές ζώνες σε μια πόλη και να βοηθήσει στον 

σχεδιασμό αντιπλημμυρικών έργων. 

2. Ανάλυση και Σχεδιασμός Υποδομών. Η υδραυλική ανάλυση με το HEC-

RAS είναι ζωτικής σημασίας για τον σχεδιασμό και την κατασκευή 

υδραυλικών έργων όπως γέφυρες, φράγματα και κανάλια. Το λογισμικό 

μπορεί να μοντελοποιήσει την επίδραση αυτών των υποδομών στη ροή του 

νερού και να βοηθήσει στην αποφυγή καταστροφικών αποτελεσμάτων από 

λανθασμένο σχεδιασμό. 

3. Διαχείριση Υδάτινων Πόρων. Το HEC-RAS χρησιμοποιείται για τη 

διαχείριση των υδάτινων πόρων, προσφέροντας εργαλεία για την 

προσομοίωση της απορροής και της ροής σε φυσικά και τεχνητά κανάλια. 

Αυτό είναι κρίσιμο για τη διατήρηση της ποιότητας του νερού και την 

αποδοτική χρήση των υδάτινων πόρων. 

4. Περιβαλλοντική Ανάλυση. Το λογισμικό μπορεί να χρησιμοποιηθεί για την 

αξιολόγηση των περιβαλλοντικών επιπτώσεων διαφόρων έργων και την 

ανάλυση της αποκατάστασης υδάτινων συστημάτων. Για παράδειγμα, μπορεί 

να βοηθήσει στη μελέτη της αποκατάστασης ποταμών και στην ανάλυση των 

επιπτώσεων της ρύπανσης. 

3.5 Λειτουργίες και Τεχνολογία 

Το HEC-RAS προσφέρει μια σειρά από τεχνικές λειτουργίες και χαρακτηριστικά 

που το καθιστούν απαραίτητο εργαλείο για τους μηχανικούς και τους υδρολόγους: 
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1. Μοντελοποίηση 1D και 2D Οι δυνατότητες μοντελοποίησης 1D 

περιλαμβάνουν την ανάλυση της ροής κατά μήκος μιας γραμμής (π.χ. σε έναν 

ποταμό), ενώ η 2D μοντελοποίηση επιτρέπει την ανάλυση της ροής σε δύο 

διαστάσεις, παρέχοντας πιο λεπτομερείς πληροφορίες για την κίνηση του 

νερού σε περιοχές όπως πλημμυρισμένα πεδία. 

2. Διεπαφή και Χρήση GIS Το HEC-RAS ενσωματώνεται με Γεωγραφικά 

Συστήματα Πληροφοριών (GIS), επιτρέποντας τη χρήση χωρικών δεδομένων 

για την ανάλυση και την προσομοίωση. Αυτό διευκολύνει τη δημιουργία 

λεπτομερών χαρτών πλημμυρικών ζωνών και άλλων αναλύσεων. 

3. Διαχείριση Δεδομένων και Εκθέσεις Το λογισμικό περιλαμβάνει εργαλεία 

για την αποθήκευση, τη διαχείριση και την ανάλυση δεδομένων, καθώς και 

για τη δημιουργία εκθέσεων και γραφημάτων που βοηθούν στην επικοινωνία 

των αποτελεσμάτων της ανάλυσης. 

3.6 Προβλήματα που Λύνει το HEC-RAS 

1. Προβλέψεις και Διαχείριση Πλημμυρών Η δυνατότητα του HEC-RAS να 

προβλέπει πλημμύρες βοηθά στη μείωση των κινδύνων και στην προστασία 

των ανθρώπων και των περιουσιών. Οι προσομοιώσεις μπορούν να δείξουν 

τις πιθανές επιπτώσεις μιας πλημμύρας και να καθοδηγήσουν τις αποφάσεις 

για την κατασκευή αντιπλημμυρικών έργων. 

2. Αποφυγή Λανθασμένων Υδραυλικών Σχεδιασμών Οι ακριβείς 

προσομοιώσεις ροής μπορούν να αποκαλύψουν πιθανά προβλήματα στον 

σχεδιασμό νέων υποδομών, αποφεύγοντας λάθη που μπορεί να οδηγήσουν σε 

καταστροφές ή δυσλειτουργίες. 

3. Βελτίωση της Διαχείρισης Υδάτινων Πόρων Με την προσομοίωση της 

ροής του νερού, οι διαχειριστές υδάτινων πόρων μπορούν να βελτιώσουν την 

αποδοτικότητα στη χρήση του νερού και να προστατεύσουν τους υδάτινους 

πόρους από υπερεκμετάλλευση ή ρύπανση. 

4. Επιστημονική Έρευνα και Εκπαίδευση Το HEC-RAS χρησιμοποιείται 

εκτενώς στην επιστημονική έρευνα και την εκπαίδευση, βοηθώντας τους 

ερευνητές και τους φοιτητές να κατανοήσουν καλύτερα τις δυναμικές των 

υδάτινων συστημάτων και να αναπτύξουν νέες μεθόδους και τεχνικές για τη 

διαχείρισή τους. 
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3.7 Παρουσίαση λειτουργίας προγράμματος HEC-RAS  

 
Στην παρούσα Διπλωματική Εργασία, χρησιμοποιήθηκε η έκδοση 6.4.1 του 

προγράμματος HEC-RAS και η οποία δεν διαφέρει σημαντικά από τις προσφάτως 

προηγούμενες. Στη συνέχεια, αναλύεται η μεθοδολογία και τα βήματα που πρέπει να 

ακολουθηθούν στο συγκεκριμένο υδραυλικό πρόγραμμα, με στόχο την δημιουργία 

και μελέτη ενός ψηφιακού μοντέλου. 

Αρχικά, στις εικόνες 16 έως 19, επισημαίνονται οι αρχικές ενέργειες που 

πρέπει να κάνει ο χρήστης, όπως τη δημιουργία συγκεντρωτικού φακέλου για τα 

αρχεία, αποφεύγοντας τα λάθη κατά την εκκίνηση του προγράμματος. Στη συνέχεια, 

όπως φαίνεται στις εικόνες 20 και 21, γίνεται επιλογή του Geometry Data, όπου 

σχεδιάζεται χειροκίνητα το ιδανικό κανάλι / αγωγός που ενδιαφέρει τον χρήστη. 

Έπειτα, καθορίζονται τα γεωμετρικά χαρακτηριστικά των διατομών του αγωγού 

σύμφωνα με τις επιλογές που διακρίνονται στης εικόνες 7 έως 10.  

Προχωρώντας στις εικόνες 21 έως 30, διαμορφώνονται τα αντίστοιχα 

χαρακτηριστικά των υπόλοιπων διατομών και απαραίτητη αποθήκευση στον αρχικό 

φάκελο. Γίνεται ύστερα επιλογή Steady Flow Data, όπως φαίνεται στις εικόνες 31 

έως 35, με σκοπό τον χειροκίνητο προσδιορισμό των επιμέρους λεπτομερειών της 

ροής, με ταυτόχρονη αποθήκευση.  

Όπως φαίνεται στην εικόνα 36, έχει ολοκληρωθεί το ψηφιακό μονέλο, 

σύμφωνο με τα διάφορα χαρακτηριστικά και λεπτομέρειες που καθορίστηκαν και 

επιτρέπεται η εκκίνηση στην εικόνα 37, του μοντέλου. Η αξιολόγηση των 

εισαχθέντων πληροφοριών εμφανίζεται πλέον στην εικόνα 39, όπου γίνεται 

αντιληπτό από το πρόγραμμα, η πιθανή ύπαρξη λάθους. Στις εικόνες 40 έως 43 

δίνεται η δυνατότητα εμφάνισης των λεπτομερειών της ροής, όπως τα ύψη της 

ελεύθερης επιφάνειας και η ταχύτητα, καθώς και τα εγκάρσια ή διαμήκη προφίλ του 

αγωγού. Τέλος, επιλέγεται η εντολή XS Interpolation, που επιτρέπει την τοποθέτηση 

πλέον, νέων διατομών στον αγωγό, ανά καθορισμένη απόσταση και χαρακτηριστικά. 
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Εικόνα 15: Δημιουργία φακέλου προς αποθήκευση των σχετικών αρχείων. 

 

Εικόνα 16: Εκκίνηση του προγράμματος. 
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Εικόνα 17: Δημιουργία προγράμματος. 

 

 

Εικόνα 18: Επιλογή αρχικού δημιουργηθέντα φακέλου για αποθήκευση δεδομένων. 
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Εικόνα 19: Επιλογή Geometry Data. 

 

 

Εικόνα 20: Σχεδίαση με το χέρι υποτιθέμενου μοντέλου και ονοματοδοσία του. 
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Εικόνα 21: Εντολή Cross Section Data. 

 

 

 

Εικόνα 22: Options -> Add a new Cross Section.  
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Εικόνα 23: Εκκίνηση αρίθμησης διατομών. 

 

 

 

 

Εικόνα 24 Προσδιορισμός γεωμετρικών χαρακτηριστικών της διατομής. 
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Εικόνα 25: Options -> Add a new Cross Section. 

 

 

Εικόνα 26: Προσδιορισμός γεωμετρικών χαρακτηριστικών της επόμενης και κάθε 

επόμενης διατομής. 



44  

 

Εικόνα 27: Προσδιορισμός γεωμετρικών χαρακτηριστικών της τελικής  διατομής. 

 

 

 

Εικόνα 28: File -> Save Geometry Data για αποθήκευση των χαρακτηριστικών της 

διατομής. 
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Εικόνα 29: Επιλογή αντίστοιχου φακέλου για αποθήκευση. 

 

 

Εικόνα 30: Steady Flow Data για εισαγωγή στοιχείων ροής. 
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Εικόνα 31: Καθορισμός παροχής Q ψηφιακού μοντέλου. 

 

 

Εικόνα 32: Reach Boundary Conditions για προσδιορισμό συνθηκών ροής 

ανάντι και κατάντι του καναλιού. 
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Εικόνα 33: Προσδιορισμός μιας εκ των τεσσάρων επιλογών συνθήκης για τα δυο 

σημεία. 

 

 

Εικόνα 34: File -> Save Flow Data για αποθήκευση συνθηκών ροής. 
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Εικόνα 35: Επιλογή αντίστοιχου φακέλου για αποθήκευση. 

 

 

 

 

 

Εικόνα 36: Run -> Steady Flow Analysis. 
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Εικόνα 37: Compute για εκκίνηση ψηφιακού μοντέλου. 

 

 

 

 

Εικόνα 38: Εμφάνιση αξιολόγησης των εισαχθέντων δεδομένων. 
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Εικόνα 39: Profile Plot για εμφάνιση του μοντέλου στον διαμήκη άξονα. 

 

 

 

Εικόνα 40: Cross Section για εμφάνιση του μοντέλου στον εγκάρσιο άξονα. 
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Εικόνα 41: Cross Section Output προς ανάδειξη αποτελεσμάτων του μοντέλου σε 

κάθε διατομή. 

 

 

Εικόνα 42: Profile Output Table προς ανάδειξη αποτελεσμάτων του μοντέλου 

συνολικά. 
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Εικόνα 43: Tools -> XS Interpolation-> Within a Reach για αύξηση των 

ενδιάμεσων διατομών ανάμεσα των χειροκίνητα τοποθετημένων. 

 

 

Εικόνα 44: Καθορισμός ελάχιστης απόστασης μεταξύ των νέων διατομών κι 

εφαρμογή τους στο μοντέλο. 
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Εικόνα 45 File-> Save Geometry Data για αποθήκευση των νέων δεδομένων. 

 

4 Κεφάλαιο 4: Αριθμητικά αποτελέσματα και ανάλυση 

 

Ο προσδιορισμός της στάθμης της ελεύθερης επιφάνειας μπορεί να γίνει για 

υποκρίσιμη, υπερκρίσιμη ή μικτή ροή. Η ανάλυση γίνεται από κατάντη προς ανάντη 

για υποκρίσιμη ροή και από ανάντη προς κατάντη για υπερκρίσιμη ροή. Το 

υδραυλικό πρόγραμμα που χρησιμοποιήθηκε έχει τη δυνατότητα ελέγχου της 

κατάστασης της ροής με βάση τον αριθμό Froude και μπορεί να προσομοιώνει 

περιπτώσεις όπου εμφανίζονται εναλλαγές των καταστάσεων ροής. Κατά την 

αριθμητική προσομοίωση υπάρχει η δυνατότητα να προσομοιάζονται διάφορες 

κατασκευές και εμπόδια κατά μήκος της ροής, όπως αναβαθμοί και διάφορα εμπόδια.  

Τέλος, μπορούν να θεωρηθούν διαφορετικοί συντελεστές τραχύτητας στην 

κεντρική κοίτη και στις πλημμυρικές κοίτες, υπολογίζοντας την παροχή είτε χωριστά 

σε κάθε τμήμα της διατομής δίνοντας τη συνολική παροχή ως άθροισμα των 

επιμέρους παροχών, είτε καθορίζοντας την ίδια παροχή για όλο το μήκος του αγωγού. 

Η διαδικασία που ακολουθήθηκε στα διάφορα υδραυλικά μοντέλα 

περιλαμβάνει τη ψηφιακή δημιουργία ανοικτών αγωγών και μόνο, στους οποίους 

τοποθετήθηκαν εμπόδια – αναβαθμοί με στόχο την μελέτη της ροής και των 

επιμέρους χαρακτηριστικών της. Συγκεκριμένα, για να εξετασθούν οι μεταβολές και 

οι συγκλίσεις της ροής και του αγωγού χρησιμοποιήθηκε πληθώρα ψηφιακών 

μοντέλων με την χρήση του προγράμματος HEC-RAS.  
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Αναλυτικά, για να σημειωθούν και να παρατηρηθούν οι διάφορες μεταβολές 

της ροής, στους ορθογωνικούς αγωγούς που χρησιμοποιήθηκαν στα μοντέλα ήταν 

αναγκαίος ο χειροκίνητος καθορισμός των χαρακτηριστικών τόσο των ίδιων των 

διατομών του, όσο και των χαρακτηριστικών της ροής. Αρχικά, οι διάφοροι αγωγοί 

διέφεραν ως προς το μήκος τους, με μεγέθη από εκατό (100 m) έως διακόσια (200 m) 

μέτρα. Παράλληλα, σημαντική κρίθηκε η μεταβολή της κλίσης του καναλιού με 

διακύμανση από 10/1000 έως 0,1/1000.  

Συμπληρωματικά, ιδιαίτερες αλλαγές σημειώθηκαν με την μεταβολή του 

συντελεστή τραχύτητας (Συντελεστής Manning) όπου οι τιμές που χρησιμοποιήθηκαν 

βάσει υλικού είναι από 0.01 έως 0,03. Στον αγωγό επίσης προς παρακολούθηση της 

συμπεριφοράς του νερού στους άνωθι καθορισμένους αγωγούς, τοποθετήθηκαν στα 

μοντέλα αναβαθμοί και εμπόδια ποικίλων χαρακτηριστικών, χάρη των οποίων 

παρατηρήθηκαν έντονες διακυμάνσεις της ελεύθερης επιφάνειας. Σημειώνοντας, 

διαμορφώνεται ανάλογα το πλάτος του αγωγού από ένα (1 m) έως δύο (2 m) μέτρα, 

ενώ τα ύψη των εκάστοτε διαφέρουν δίχως να επηρεάζουν τα χαρακτηριστικά της 

ροής του μοντέλου.  Όσον αφορά τη ροή, ενδεικτικές μεταβολές πραγματοποιήθηκαν 

χειροκίνητα στην παροχή του καναλιού, με μέγιστη αυτή του ενός κυβικού μέτρου το 

δευτερόλεπτο (1 m3/s ).    

Για την καλύτερη κατανόηση των αποτελεσμάτων, κρίνεται αναγκαία η 

διευκρίνιση κάποιων εννοιών. Ειδικότερα: 

 η ομοιόμορφη ροή χαρακτηρίζεται από σταθερό βάθος ροής y και ταχύτητα V 

 μη ομοιόμορφη είναι η ροή η ταχύτητα V και το βάθος ροής y μεταβάλλονται 

στην κατεύθυνση της ροής στον αγωγό. 

 ογκομετρική παροχή του ρευστού ορίζεται ως Q = V A όπου V η μέση 

ταχύτητα κάθετη επί της διατομής Α του αγωγού. 

 εμβαδόν διατομής ορίζεται το πλάτος πυθμένα B επί το βάθος ροής y. 

 κανονικό (ομοιόμορφο) βάθος ροής, θεωρείται το βάθος της ομοιόμορφης 

ροής yn και το οποίο δεν μεταβάλλεται κατά μήκος του αγωγού. 

 ο αριθμός Froude (Fr) κατηγοριοποιεί και χαρακτηρίζει τη ροή ως 

υποκρίσιμη, υπερκρίσιμη και κρίσιμη, ενώ ισούται με 
𝑉

√𝑔 ℎ
 για ορθογωνικής 

διατομής αγωγούς με αριθμητικό κριτήριο την μονάδα (1) 
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 υδραυλικό άλμα παρατηρείται όταν μια ροή μεταπίπτει από συνθήκες 

υπερκρίσιμης ροής (Fr > 1) σε συνθήκες υποκρίσιμης (Fr < 1) και 

αντίστροφα, όπου εντοπίζεται μεταβολή της στάθμης και της ταχύτητας του 

ρευστού με παράλληλο τοπικό στροβιλισμό της ροής. 

 αναβαθμός λογίζεται οποιοδήποτε εμπόδιο τοποθετημένο εγκάρσια της 

διατομής του αγωγού με ποικίλες ιδιότητες  

 

 

Στα διάφορα ψηφιακά μοντέλα που αναλύθηκαν και σχεδιάστηκαν με τη χρήση 

του προγράμματος HEC - RAS, ιδιαίτερα κρίνονται τα αποτελέσματα στα οποία 

στηρίχθηκε η παρούσα Διπλωματική Εργασία. Συγκεκριμένα, στα υδραυλικά 

μοντέλα που σχηματίστηκαν με τη βοήθεια του προγράμματος, θεωρήθηκε σε όλα 

ανοικτός αγωγός με ήπια κλίση πυθμένα. Η ροή, σύμφωνα με την ανάλυση του 

προγράμματος είναι μονοδιάστατη και ομοιόμορφη με μεταβολές στα σημεία όπου 

επιδιώκεται. 

 

Επιπροσθέτως, στους ανοικτούς αγωγούς που μελετήθηκαν, τέθηκε συγκεκριμένη 

παροχή, με στόχο την παρατήρηση της ελεύθερης επιφάνειας και των 

χαρακτηριστικών της. Εντοπίζονται συγκεκριμένα μεταβολές στις ταχύτητες της 

ροής, στα βάθη και στον αριθμό Froude, έννοιες που αναλύθηκαν παραπάνω, σε 

αγωγούς με διαφορετική κλίση ή με αναβαθμούς. 

 

Αναφορικά με τους αναβαθμούς που τοποθετήθηκαν στα ανοικτά κανάλια, έγινε 

χρήση τους, με στόχο τον χαρακτηρισμό της ροής σύμφωνα με τον αριθμό Fr, καθώς 

και τον εντοπισμό πιθανού υδραυλικού άλματος. Οι αναβαθμοί εδράζονται κατά 

μήκος του αγωγού, εγκάρσια στην διατομή του και ποικίλουν στα γεωμετρικά 

χαρακτηριστικά, σύμφωνα με τις λεπτομέρειες στο προηγούμενο κεφάλαιο. Τέλος, ως 

εμπόδια τοποθετήθηκαν θίνες επίσης εγκάρσια των διατομών, χάριν στις οποίες 

παρατηρήθηκαν έντονες μεταβολές στην ελεύθερη επιφάνεια της ροής και των 

μεγεθών της. 

 

Τα χαρακτηριστικά των αγωγών και των δοκιμών που πραγματοποιήθηκαν, 

αναγράφονται αναλυτικά πάνω από το εκάστοτε ψηφιακό μοντέλο. 
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4.1 Σενάριο 1: Ροή ανοικτού αγωγού υπεράνω ορθογωνικού αναβαθμού 

 

Ψηφιακό μοντέλο 1: 

 Στο παρόν ψηφιακό μοντέλο σχεδιάστηκε ανοικτός αγωγός μήκους 100 m 

και πλάτους 2 m  (μέτρα). Η κλίση του ανοικτού καναλιού καθορίστηκε σε 1/100 

m/m και ο συντελεστής τραχύτητας σε 0,03. Η παροχή που καθορίστηκε ανέρχεται σε 

1 m3/ s. Για την μελέτη της ελεύθερης επιφάνειας και την συμπεριφορά της σε 

εμπόδιο, τοποθετήθηκε εγκάρσια στον αγωγό ορθογωνικός αναβαθμός που 

καταλαμβάνει ολόκληρη την επιφάνεια της διατομής πλάτους 2 m, με ύψος 1 m και 

μήκος επίσης 1 m.    

 

 

 

Εικόνα 46: Ροή υπεράνω ορθογωνικού αναβαθμού 

 

 

Εικόνα 47: Μεγέθυνση στη στέψη του αναβαθμού 

 

Διάγραμμα 1: Βάθη ροής κατά μήκος του αγωγού 
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Στον ανοικτό αγωγό κλίσης S = 1/100 m/m, τέθηκε παροχή Q = 1 m3/s και 

συνοριακή συνθήκη στο ανάντη τμήμα του αγωγού y = 1 m. Παρατηρήθηκε στην 

πρώτη διατομή του αγωγού αριθμός Fr = 0,42 και ροή υποκρίσιμη μέχρι την διατομή 

αμέσως πριν του αναβαθμού. Μέχρι αυτό το σημείο, η ροή παραμένει υποκρίσιμη, 

ενώ καθώς η ροή διέρχεται πάνω από τον αναβαθμό γίνεται κρίσιμη και συνεχίζει σε 

υπερκρίσιμη, προξενώντας τη δημιουργία υδραυλικού άλματος. Η μέγιστη τιμή του 

αριθμού Fr παρατηρείται στην διατομή της στέψης του αναβαθμού και ισούται με 

2,66. Η ταχύτητα ακολουθεί την πορεία του αριθμού Fr, είναι δηλαδή μέγεθος 

ανάλογό του. Συγκεκριμένα, στην διατομή προ του εμποδίου ισούται με 0,98 m/s, 

γίνεται μέγιστη στη στέψη του και έπειτα μειώνεται μέχρι 0,42 στην τελευταία 

διατομή στο κατάντη μέρος του αγωγού. 

 

4.2 Σενάριο 2: Εγκάρσια τοποθέτηση ορθογωνικού και τραπεζοειδούς 

αναβαθμού καθορισμένου ύψους 

Ψηφιακά μοντέλα 2 & 3:  

 

Στη συνέχεια σχεδιάστηκε ανοικτός αγωγός μήκους 100 m και πλάτους 2 m  

(μέτρα). Η κλίση του ανοικτού καναλιού θεωρήθηκε 1/1000 m/m και ο συντελεστής 

τραχύτητας σε 0,02. Η παροχή καθορίστηκε σε 1 m3/ s. Για την μελέτη της ελεύθερης 

επιφάνειας και την συμπεριφορά της σε εμπόδιο, τοποθετήθηκε εγκάρσια στον αγωγό 

ορθογωνικός αναβαθμός που καταλαμβάνει ολόκληρη την επιφάνεια της διατομής 

πλάτους 1 m, με ύψος 0,3889 m και μήκος 2 m.    

 

 

Εικόνα 48: Ροή υπεράνω ορθογωνικού αναβαθμού 
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Εικόνα 49: Μεγέθυνση στη στέψη του αναβαθμού 

 

 

Διάγραμμα 2: Βάθη ροής κατά μήκος του αγωγού 

 

Δοκιμάστηκε ύστερα ανοικτός αγωγός μήκους 100 m και πλάτους 2 m  

(μέτρα). Η κλίση του καθορίστηκε σε 1/1000 m/m και ο συντελεστής τραχύτητας σε 

0,02, η παροχή που καθορίστηκε ανέρχεται σε 1 m3/ s. Χρησιμοποιήθηκαν ίδια 

χαρακτηριστικά ροής και διατομής αποσκοπώντας στην μελέτη της ελεύθερης 

επιφάνειας και την συμπεριφορά της σε εμπόδιο. Συνεπώς εγκάρσια στον αγωγό 

τοποθετήθηκε  τραπεζοειδής κι όχι ορθογωνικός αναβαθμός που καταλαμβάνει 

ολόκληρη την επιφάνεια της διατομής πλάτους 1 m, με ύψος 0,3889 m, μήκος 

μεγάλης πλευράς 10 m και μικρής 2 m. 

 

 

Εικόνα 50: Ροή υπεράνω τραπεζοειδούς αναβαθμού 
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Εικόνα 51: Μεγέθυνση στη στέψη του αναβαθμού 

 

Διάγραμμα 3: Βάθη ροής κατά μήκος του αγωγού 

Διατηρώντας στον ανοικτό αγωγό την ίδια παροχή και σταθερό πλάτος 

πυθμένα B = 2 m, εξετάστηκε η συμπεριφορά της ροής σε ορθογωνικό αναβαθμό, 

μικρότερου ύψους. Αναλυτικά, υπολογίστηκαν: 

 

Με γνωστά Β, Q προκύπτει η μέση παροχή του καναλιού,  

q = 
𝑄

𝐵
 = 

1

2
 = 0,5 m3/s 

(11) 

από την οποία υπολογίζεται το κρίσιμο βάθος 

yc = √
𝑞2

𝑔

3
 = 0,2943 m 

(12) 

με σκοπό τον προσδιορισμό της υδραυλικής ακτίνας 

Rhc = 
𝐵 𝑦𝑐

𝐵+2 𝑦𝑐
 = 0.2274 m 

(13) 

έτσι ώστε με την βοήθεια της εξίσωσης Manning να βρεθεί η κλίση του πυθμένα.  
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Q = A  
1

𝑛
  𝑅ℎ

2

3  𝑆
1

2  = B yc  
1

𝑛
  𝑅ℎ

2

3 𝑆
1

2  =>𝑆𝐶

1

2 = 
𝑄 𝑛

𝐵 𝑦𝑐  𝑅ℎ
2
3 

 = 0,1354 m 

(14) 

Από την ίδια εξίσωση με Α = Β y και Rh = 
𝐵 𝑦

𝐵+2 𝑦
 , έχοντας γνωστά τα n,Q,S, 

υπολογίζεται με δοκιμές το βάθος ροής y στον αγωγό. 

 

A  𝑅ℎ
2

3 = 
𝑛 𝑄

𝑆
1
2

 => y1= 0,811 m 

(15) 

Λαμβάνοντας υπ’ όψιν τους παραπάνω υπολογισμούς, το απαιτούμενο ύψος 

αναβαθμού από το οποίο η ροή περνά με κρίσιμο βάθος προκύπτει αφαιρώντας από 

την ενέργεια που έχει η ροή πριν φτάσει στο εμπόδιο, την ενέργεια που θα είχε με το 

κρίσιμο βάθος. Αναλυτικότερα με την εξίσωση της συνέχειας υπολογίζεται η 

ταχύτητα στο σημείο με βάθος y1 και με την εξίσωση της ενέργειας, η ενέργεια για 

βάθος y1 και yc. 

Q = U A => U = 
𝑄

𝐴
=

𝑄

𝛣 𝑦1
 = 0,616 m/s 

(16) 

E1 = y1 + 
𝑈1

2

2 𝑔
 = 0.8303 m 

(17) 

Ε2 = yc + 
𝑈2

2

2 𝑔
 = Emin = yc + 

𝑈𝑐
2

2 𝑔
 = 0,4414 m 

(18) 

E1 – ΔΖ = E2 => ΔΖ = Ε1 – Ε2 =0,3889 m 

(19) 

 

 

Θεωρήθηκε λοιπόν σύμφωνα με τα αποτελέσματα που προέκυψαν από τους 

άνωθι υπολογισμούς, αναβαθμός ύψους 0,3889 m. Συγκεκριμένα, το ύψος Δz = 

0,3889 m αποτελεί το μέγιστο ύψος αναβαθμού για το οποίο δεν θα υπάρχουν 

απώλειες ενέργειας στον αγωγό. Χρησιμοποιήθηκε η εξίσωση ενέργειας, όπως 
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φαίνεται και παραπάνω με ταχύτητες U1 ακριβώς πριν τον αναβαθμό και U2 αμέσως 

μετά. Κρίνεται ως σενάριο αγωγού αρκετά ιδανικό, διότι δεν συμπεριλαμβάνονται η 

τραχύτητα κι η κλίση του και στηρίζει τις ενεργειακές απώλειες στα βάθη ροής και 

στις ταχύτητες. Επομένως, όπως ήταν αναμενόμενο εμφανίσθηκαν διαφορές στα 

αποτελέσματα που προέκυψαν από το ψηφιακό μοντέλο, με απόκλιση της τάξεως του 

εκατοστού. 

 

Προς επιβεβαίωση και έλεγχο των ανωτέρω αποτελεσμάτων, εφαρμόσθηκε 

αρχικά στον αγωγό ορθογωνικός αναβαθμός. Οι αριθμοί του Fr κυμάνθηκαν στην 

ίδια συχνότητα με το προηγούμενο μοντέλο, εμφανώς βέβαια μειωμένοι εξαιτίας του 

χαμηλότερου σε ύψος αναβαθμού. Δημιουργήθηκε υδραυλικό άλμα μικρότερου 

μήκους με τον μεγαλύτερο αριθμό Fr να προκύπτει 1,01 στην στέψη του εμποδίου. Η 

ροή έγινε δηλαδή κρίσιμη και οριακά υπερκρίσιμη, προκαλώντας έτσι το άλμα στο 

κατάντη τμήμα του αγωγού. 

 

Για λόγους σύγκρισης, δοκιμάστηκε στην επόμενη και άμεσα συνυφασμένη 

με το παραπάνω δοκιμή, εμπόδιο ίδιου ύψους (0,3889 m) τραπεζοειδούς διατομής. Τα 

συμπεράσματα που προέκυψαν ήταν τα αναμενόμενα βάσει των υπολογισμών με 

τους αριθμούς Fr και της ταχύτητας να μην έχουν μεγάλες διαφοροποιήσεις με την 

προηγούμενη δοκιμή. 

  

Ο αριθμός Fr στη στέψη έφτασε το μέγιστο στα 1,18, στην περίπτωση του 

τραπεζοειδούς αναβαθμού. Οι δοκιμές υπ’ αριθμόν 2 και 3, παρουσίασαν 

ενδιαφέρουσες συγκλίσεις στους αριθμούς Fr πριν (=0,89) και μετά (0,95) τον 

αναβαθμό με πτωτική κατάντη πορεία. Οι ταχύτητες στην πρώτη διατομή του αγωγού 

ήταν αμφότερες ίσες με 0,63 m/s, 1,57 m/s πριν και 0,82 μετά τον αναβαθμό. Η 

μέγιστη παρουσιάστηκε στην στέψη, όπου στον ορθογωνικό αναβαθμό έφτασε το 

1,70 m/s, ενώ αντίστοιχα στην στέψη του τραπεζοειδούς το 1,89 m/s. 
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4.3  Σενάριο 3: Τραπεζοειδής αναβαθμός διαφορετικού ύψους σε δύο ψηφιακά 

μοντέλα 

Ψηφιακά μοντέλα 4 & 5: 

Εν συνεχεία, σχεδιάστηκε ανοικτός αγωγός μήκους 100 m και πλάτους 2 m  

(μέτρα). Η κλίση του ανοικτού καναλιού καθορίστηκε σε 1/1000 m/m και ο 

συντελεστής τραχύτητας σε 0,03. Η παροχή καθορίστηκε εκ νέου 1 m3/ s. Για την 

μελέτη της ελεύθερης επιφάνειας και την συμπεριφορά της σε εμπόδιο, τοποθετήθηκε 

εγκάρσια στον αγωγό νέος τραπεζοειδής αναβαθμός που καταλαμβάνει ολόκληρη την 

επιφάνεια της διατομής πλάτους 2 m, με ύψος 1 m, μήκος μεγάλης πλευράς - βάση 10 

m και μικρής 0,5 m. 

 

 

Εικόνα 52: Ροή υπεράνω τραπεζοειδούς αναβαθμού 

 

 

Εικόνα 53: Μεγέθυνση στη στέψη του αναβαθμού 

 

 

Διάγραμμα 4:  Βάθη ροής κατά μήκος του αγωγού 
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Ως νέο μοντέλο θεωρήθηκε ανοικτός αγωγός μήκους 100 m και πλάτους 1 m  

(μέτρα). Η κλίση του ανοικτού καναλιού είναι και πάλι μειωμένη και συγκεκριμένα 

1/1000 m/m με συντελεστή τραχύτητας σε 0,03. Η παροχή που καθορίστηκε 

ανέρχεται σε 1 m3/ s. Τοποθετήθηκε εγκάρσια στον αγωγό νέων διαστάσεων 

τραπεζοειδής αναβαθμός που καταλαμβάνει ολόκληρη την επιφάνεια της διατομής 

πλάτους 1 m, με ύψος 1 m, μήκος βάσης 10 m και μήκος μικρής πλευράς αντίστοιχα 

1 m. 

 

 

Εικόνα 54: Ροή υπεράνω τραπεζοειδούς αναβαθμού 

 

Εικόνα 55: Μεγέθυνση στη στέψη του αναβαθμού 

 

Διάγραμμα 5: Βάθη ροής κατά μήκος του αγωγού 

Στην επόμενη δοκιμή εφαρμόστηκε κλίση αγωγού ίση με 0,001 m/m, και 

τοποθετήθηκε τραπεζοειδές εμπόδιο. Η παροχή διατηρήθηκε σταθερή (= 1 m3/s), ενώ 

αυξήθηκε το ύψος και το μήκος του αναβαθμού συγκριτικά με του προηγούμενου. 

Δεν παρατηρήθηκαν αξιοσημείωτες πλέον μεταβολές με τους αριθμούς Fr και 
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ταχύτητας να κυμαίνονται στα ίδια πλαίσια, παρά μόνο το μήκος του υδραυλικού 

άλματος που λόγω μεγαλύτερου αναβαθμού σε μήκος, αυξήθηκε κι αυτό. 

 

Από την άλλη, ιδιαίτερη αύξηση σημειώθηκε στον αριθμό Fr της περίπτωσης 

5 στη στέψη του αναβαθμού, όπου έφτασε το 2,87 με πτωτική στη συνέχεια πορεία. 

Ο αντίστοιχος της περίπτωσης 4 άγγιξε το 1,69 με παρόμοια έπειτα συμπεριφορά. 

 

4.4 Σενάριο 4: Ανοικτός αγωγός με κλίση, χωρίς εμπόδιο 

Ψηφιακό μοντέλο 6 

Προς επιβεβαίωση κάποιων αποτελεσμάτων των άνωθι ψηφιακών μοντέλων, 

σχεδιάστηκε νέος ανοικτός αγωγός μήκους 200 m και πλάτους 1 m  (μέτρα). Η κλίση 

του ανοικτού καναλιού καθορίστηκε σε 0,35/1000 m/m και ο συντελεστής 

τραχύτητας, 0,01. Η παροχή που καθορίστηκε ανέρχεται σε 0,94 m3/ s. Δεν 

τοποθετήθηκε αναβαθμός, παρά μόνο ελέγχθησαν η εγγύτητα και η ακρίβεια 

συγκεκριμένων αποτελεσμάτων που αναλύονται σε παρακάτω κεφάλαιο.  

 

Εικόνα 56: Ανοικτός αγωγός και ροή υπό κλίση 

 

Εικόνα 57: Βάθη ροής κατά μήκος του αγωγού 

Για τη σωστή διεξαγωγή των δοκιμών, απαιτήθηκε η δημιουργία ψηφιακού 

μοντέλου, με αποκλειστική χρήση αυτή της σύγκρισης με τα προηγούμενα και 

επόμενα αποτελέσματα από τα υπόλοιπα μοντέλα. Θεωρήθηκε ανοικτός αγωγός 

αρκετά ήπιας κλίσης (0,106 m/m) με παροχή 0,94 m3/s και πλάτος πυθμένα 1 m, 
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δίχως να αγγίζει μεγάλη ταχύτητα διατομής και αριθμό Fr, συγκεκριμένα 0,55 m/s και 

0,13. Αποτελεί με αυτό τον τρόπο, ένδειξη της ροής σε αγωγό δίχως αναβαθμού με 

απόρροια την απουσία υδραυλικού άλματος. 

 

4.5 Σενάριο  5: Κλιμακωτές θίνες σε όλο το μήκος του ανοικτού αγωγού 

Ψηφιακό μοντέλο 7 

Έπειτα, τοποθετήθηκαν σε ανοικτό αγωγό μήκους 100 m και πλάτους 2 m  

(μέτρα), θίνες ως φυσικά εμπόδια. Η κλίση του ανοικτού καναλιού καθορίστηκε σε 

1/100 m/m και ο συντελεστής τραχύτητας σε 0,03. Η παροχή που καθορίστηκε 

ανέρχεται σε 0,94 m3/ s. Προς διευκόλυνσης της μελέτης της ελεύθερης επιφάνειας 

και την συμπεριφορά της ροής απέναντι στις θίνες, θεωρήθηκαν δέκα (10) θίνες που 

καταλαμβάνουν όλο το μήκος του καναλιού. Αναλυτικά, η γεωμετρία αυτών είναι 

τριγωνική με οριζόντιο μήκος 10 m, κάθετο επ’ αυτού ύψους 2,5 m και πλάτος 

εγκάρσια ολόκληρο το πλάτος της διατομής 2 m. Η γεωμετρία των θινών, 

προσδιορίστηκε με τη χρήση της εξίσωσης των Kadota & Nezu (1999), η οποία είναι 

η εξής:  

Hdune(x) = 10.0 (sin (π(2X + 
1

2
)) + 1) 

(20) 

Όπου: 

Χ = 20x’ / 38  - 0,95 < x ’< 0,0 

Χ = 10x’ – 9 0,0 < x’ < 0.05 

 

 
Εικόνα 58: Ροή υπεράνω κλιμακωτών θινών 
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Διάγραμμα 6: Βάθη ροής κατάμήκος του αγωγού 

 

Προς μελέτη της επίδρασης φυσικών εμποδίων σε ροή, τοποθετήθηκαν 

εγκάρσια των διατομών βαθμωτοί αναβαθμοί (θίνες), μήκους έκαστη 10 m. Πιο 

συγκεκριμένα, παρουσιάστηκε αριθμός Fr = 0,3 στην πρώτη διατομή του αγωγού και 

ταχύτητα U = 0,76 m/s. Αξιοσημείωτος είναι ο αριθμός Fr που προκύπτει στη στέψη 

των αρχικών τεσσάρων θινών, όπου ισούται σε όλα με 1,56. Γίνεται μια συνεχής 

εναλλαγή μεταξύ υποκρισίμου και υπερκρισίμου ροής στις θίνες που αναφέρθηκαν, 

με αποτέλεσμα την δημιουργία υδραυλικού άλματος σε αυτές. Στην κατά σειρά 

πέμπτη θίνα, ο αριθμός Fr πλησιάζει τη μονάδα του κρισίμου, αλλά σταματάει την 

αύξουσα συμπεριφορά της στο 0,9, αποφεύγοντας έτσι την εναλλαγή της 

συμπεριφοράς της ροής, καθώς και τη δημιουργία υδραυλικού άλματος. Παρόμοια 

αντιμετώπιση της ροής, φαίνεται και στις υπόλοιπες κατά σειρά θίνες, όπου 

συνεπάγεται φθίνουσα ταχύτητα και αριθμού Fr, μέχρι την τελική διατομή του 

αγωγού. 

 

4.6 Σενάριο 6: Θίνες ύψους 0,25 m σε ανοικτό αγωγό κλίσης 0,35/1000 m/m 

Ψηφιακό μοντέλο 8 

Μελετώντας την ελεύθερη επιφάνεια πάνω από θίνες σε ανοικτό αγωγό 

μήκους 200 m και πλάτους 1 m  (μέτρα), τέθηκε παροχή 0,94 m3/ s. Η κλίση του 

ανοικτού καναλιού επαναλήφθηκε ως  0,35/1000 m/m και ο συντελεστής τραχύτητας 

σε 0,01.  Τοποθετήθηκαν πέντε (5) θίνες στα 90 m ανάντη και στα 85 m κατάντη. 

Αναλυτικά, η γεωμετρία αυτών είναι τριγωνική με οριζόντιο μήκος  5 m, κάθετο επ’ 

αυτού ύψους 0,25 m και πλάτος εγκάρσια ολόκληρο το πλάτος της διατομής 1 m. 

Επεξηγηματικά, η μεγάλη πλευρά του σχηματισθέντος τριγωνικού πρίσματος  είναι 

4,75 m και η μικρή 0,35 m. 
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Εικόνα 59: Ροή υπεράνω θινών ύψους 0,25 m 

 

Εικόνα 60: Μεγέθυνση της ροής στις θίνες 

 

Διάγραμμα 7: Βάθη ροής κατάμήκος του αγωγού 

 

Εξετάζοντας και πάλι τη συμπεριφορά της ροής πάνω από θίνες, 

τοποθετήθηκαν στο ψηφιακό μοντέλο πέντε (5) θίνες μειωμένου συγκριτικά με πριν 

μήκους, σε καθορισμένη απόσταση ανάντη και κατάντη. Η συγκεκριμένη δοκιμή 

στοχεύει στον προσδιορισμό του βάθους ροής στις διατομές του αγωγού, με απώτερες 

βλέψεις τη σύγκρισή των με τα αντίστοιχα του εργαστηριακού πειράματος που 

αναφέρεται παρακάτω. 

Τα φαινόμενα που παρατηρούνται στη συγκεκριμένη δοκιμή, όσον αφορά τον 

αριθμό Fr, είναι πως δεν αγγίζει την τιμή της κρίσιμης ροής. Επιπλέον, γίνονται 

αντιληπτά σύμφωνα με το διάγραμμα 22 τα διάφορα ύψη της ροής πάνω από τις 

θίνες, αναδεικνύοντας την αύξηση της ταχύτητας στα ίδια σημεία, με παράλληλη 

άνοδο των τιμών Froude, χωρίς να προκύπτουν τα κρίσιμα. 
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4.7 Σενάριο 7: Θίνες ίδιου ύψους σε ανοικτό αγωγό κλίσης 0,106/1000 m/m 

Ψηφιακό μοντέλο 9: 

Άμεσα συνυφασμένο με το παραπάνω, τοποθετήθηκαν θίνες σε ανοικτό 

αγωγό μήκους  200 m και πλάτους 1 m  (μέτρα), τέθηκε παροχή 0,94 m3/ s. Η κλίση 

του ανοικτού καναλιού μειώθηκε σε 0,106/1000 m/m και ο συντελεστής τραχύτητας 

διατηρήθηκε σε  0,01.  Οι πέντε (5) θίνες επαναπροσδιορίστηκαν στα 90 m ανάντη 

και στα 85 m κατάντη. Επαναληπτικά, η γεωμετρία αυτών είναι τριγωνική με 

οριζόντιο μήκος  5 m, κάθετο επ’ αυτού ύψους 0,25 m και πλάτος εγκάρσια 

ολόκληρο το πλάτος της διατομής 1 m, αντίστοιχων με του παραπάνω μοντέλου. 

Επίσης, η μεγάλη πλευρά του σχηματισθέντος τριγωνικού πρίσματος είναι 4,76 m και 

η μικρή 0,35 m. 

 

 

 

Εικόνα 61: Ροή υπεράνω θινών ύψους 0,25 m 

 

 

Εικόνα 62: Μεγέθυνση της ροής στις θίνες 
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Διάγραμμα 8: Βάθη ροής κατά μήκος του αγωγού 

 

Με την ίδια παροχή που χρησιμοποιήθηκε και στο προηγούμενο μοντέλο, 

αλλά με μείωση της κλίσης σε ακόμη πιο ήπια ( από 0,35/1000 παραπάνω σε 

0,106/1000), παρατηρήθηκαν αντίστοιχες μεταβολές στα ύψη βαθών. Επιπλέον, 

αποφεύχθη η τιμή του Fr να φθάσει την κρίσιμη σε όλες τις θίνες (μέγιστη ίση με 

0,59) με την ταχύτητα να κινείται από 0,94 m/s στην αρχική διατομή, έως 1,47 m/s 

στη στέψη της πρώτης θίνας. Δεν προέκυψε υδραυλικό άλμα σε καμία διατομή του 

αγωγού. 

 

Τα βάθη ροής του αναφερθέντος ανοικτού αγωγού συγκρίθηκαν με 

εργαστηριακές μετρήσεις που είναι διαθέσιμες. Από δεδομένα και αποτελέσματα του 

άρθρου Dimas et. al. (2008) που παρατίθεται στη βιβλιογραφία. Στο εν λόγω πείραμα, 

που δημοσιεύθηκε το 2008, χρησιμοποιήθηκε αγωγός σε εργαστήριο σχεδόν λείος, με 

αρκετά μικρό δηλαδή συντελεστή τραχύτητας. Η κλίση του πυθμένα ήταν 0,106/1000 

m/m, ενώ η παροχή Q = 0,94 l/s. Το μήκος του καναλιού ήταν 8 m, το πλάτος 0,1 m 

με τις διαστάσεις των θινών να είναι 50 cm το μήκος και 2,5 cm το ύψος. 

 

Το κανάλι που κατασκευάστηκε με τη χρήση του προγράμματος ακολούθησε 

τα άνωθι δεδομένα του πειράματος, πολλαπλασιαζόμενα επί 10, διατηρώντας 

σταθερή την τιμή του συντελεστή τραχύτητας (0,01). Θεωρείται δηλαδή το 

εργαστηριακό πείραμα σε μορφή κλίμακας, σε σχέση με το ψηφιακό και αντίστροφα. 

 

Τα αποτελέσματα που εξήχθησαν από την εργαστηριακή προσέγγιση, 

συγκρίνονται παρακάτω υπό τη μορφή διαγράμματος με τα αντίστοιχα του ψηφιακού 

μοντέλου. 
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Διάγραμμα 9: Σύγκριση των βαθών ροής 

Όπως προκύπτει από το διάγραμμα, οι αποκλίσεις και αριθμητικές διαφορές 

στα αποτελέσματα μεταξύ των δύο, προκύπτουν της τάξεως του εκατοστού και σε 

περιπτώσεις του χιλιοστού. Συνεπώς, γίνεται κατανοητή η συμπεριφορά της ροής 

πάνω από τις θίνες και αποδεικνύει την αύξηση της ταχύτητάς της στα σημεία αυτά, 

γεγονός που επικυρώνεται από την εξίσωση συνέχειας (Q = V A) και την ισότητα του 

εμβαδού διατομής (A = B y). 

5 Κεφάλαιο 5: Συμπεράσματα  

 

Το πρόγραμμα που χρησιμοποιήθηκε στην παρούσα μελέτη, επιτρέπει την 

δημιουργία ψηφιακών καναλιών και ανοικτών αγωγών, καθορισμένων διαστάσεων 

διατομών και ροής σε μονοδιάστατη ροή. Μπορεί επομένως να ειπωθεί πως 

εξειδικεύεται στην μελέτη και έρευνα υπαρκτών και μη καναλιών και αγωγών, όπως 

είναι τα ρέμματα, τα ποτάμια κι οι χείμαρροι, σε αυτά που συγκαταλέγονται στα 

υπαρκτά. Από την άλλη, δίνει τη δυνατότητα μελετητικής έρευνας, προ της 

κατασκευής για έργα που περιλαμβάνουν ανοικτούς αγωγούς όπως κανάλια άρδευσης 

ή αποστραγγιστικά κανάλια. 

 

  Συγκεκριμένα, το HEC - RAS, μέσω του οποίου πραγματοποιήθηκαν οι 

διάφορες προσομοιώσεις που αναφέρθηκαν παραπάνω, διευκόλυνε την έρευνα και 

παρουσίασε αναλυτικά τα αποτελέσματα της επίδρασης διαφόρων εμποδίων και 

αναβαθμών σε ευθύγραμμο, ανοικτό αγωγό ήπιας και μέτριας κλίσης.  Επιπλέον, 
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χάρη στην πληθώρα επιλογών που δίδει, δόθηκε η δυνατότητα προσομοίωσης 

αγωγών και των αντίστοιχων αναβαθμών, με φυσικά χαρακτηριστικά. 

 

Αναλυτικά, καθορίστηκαν αρχικά τα γεωμετρικά χαρακτηριστικά των 

διατομών του ανοικτού αγωγού και στη συνέχεια τέθηκαν τα φυσικά μεγέθη της ροής 

όπως η παροχή και το αρχικό βάθος ροής. Σημαντική κρίνεται η δυνατότητα του 

προγράμματος να προσομοιάζει την κλίση του πυθμένα, καθώς και του συντελεστή 

τραχύτητας, στην λήψη των τελικών αποτελεσμάτων. Δημιουργήθηκαν τέλος οι 

διάφοροι αναβαθμοί και τα ακριβή χαρακτηριστικά τους, ενώ εγκαταστάθηκαν 

εγκάρσια των διατομών. 

 

Σύμφωνα με όλα τα παραπάνω, προέκυψαν αρκετά συμπεράσματα αναφορικά 

με την ελεύθερη επιφάνεια της ροής, καθώς και για τον τρόπο με τον οποίο οι 

αναβαθμοί επηρεάζουν τη ροή. Έγινε αντιληπτό, πως στη ροή ανοικτών αγωγών, 

σημαντικό ρόλο διαδραματίζει η τραχύτητά του αγωγού, δηλαδή το υλικό από το 

οποίο είναι αυτός κατασκευασμένος. Εντοπίστηκε η επίδραση του συντελεστή  

Manning (n) μέσω των αποτελεσμάτων που υποδείκνυαν, βάσει της αντίστοιχης 

εξίσωσης, την μείωση της ταχύτητας ροής λόγω αύξησης του. Αυτό παρατηρήθηκε 

χάρη στις διάφορες τιμές που χρησιμοποιήθηκαν στις παραπάνω δοκιμές, 

διατηρώντας παράλληλα σταθερά τα υπόλοιπα χαρακτηριστικά του αγωγού. 

 

Ταυτόχρονα, με τις ποικίλες κλίσεις πυθμένα που χρησιμοποιήθηκαν στους 

αγωγούς, έγινε κατανοητό πως ενδεχόμενη αύξησή της, προμηνύει αύξηση και της 

ταχύτητας, ενώ μπορεί να συμβεί και το αντίστροφο. Τα βάθη ροής y μεταβάλλονται 

επίσης, συναρτήσει των προαναφερθέντων με παρόμοιο τρόπο. Τελικά, ο αριθμός 

Froude, ακολουθεί την συμπεριφορά της ταχύτητας, γεγονός που επικυρώνεται από 

τον τύπο της εξίσωσης του ίδιου.  

 

Αναφορικά με τους αναβαθμούς που χρησιμοποιήθηκαν και σύμφωνα με τα 

χαρακτηριστικά τους, παρουσιάστηκαν έντονες μεταβολές της ροής, τόσο πάνω από 

αυτούς, όσο και στο κατάντη τμήμα του αγωγού. Πιο ειδικά, εντοπίστηκε σε αρκετές 

από τις προαναφερθείσες περιπτώσεις, η δημιουργία υδραυλικού άλματος, γεγονός 

σημαντικό για την εξέλιξη της ροής. Το άλμα, εμφανίζεται στις περιπτώσεις όπου 

συμβαίνει εναλλαγή της κατάστασης της ροής. Εν προκειμένου, εναλλαγή 
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εμφανίζεται στις παραπάνω δοκιμές, όπου η ροή μεταβάλλεται από υποκρίσιμη σε 

υπερκρίσιμη, δημιουργώντας τοπικά τυρβώδη ροη, επηρεάζοντας τόσο τον αριθμό Fr, 

όσο και τα υπόλοιπα χαρακτηριστικά μεγέθη. 

 

Εν κατακλείδι, η λειτουργία και η ευκολία που παρέχει το πρόγραμμα, 

επιτρέπει την εξέταση και έρευνα διαφόρων υδραυλικών σεναρίων, έργων ή δοκιμών 

με πιθανό ύστατο στόχο την κατασκευή τους. Η ακρίβειά του κρίνεται από αρκετά 

επαρκής έως εξαιρετική, γεγονός που πιστοποιήθηκε από την προηγούμενη σύγκριση 

μεταξύ εργαστηριακού και ψηφιακού μοντέλου. Καταλήγοντας, αξίζει να δοθεί 

έμφαση στη σημασία του συγκεκριμένου προγράμματος, τόσο στην εργασία ενός 

Μηχανικού, όσο και στην απαιτούμενη εκμάθηση σε επίπεδο τριτοβάθμιας 

εκπαίδευσης σε φοιτητές που επιζητούν τη βελτίωση και πιθανή διατριβή σε θέματα 

υδραυλικής ανοικτών αγωγών.    
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